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Preface

Agile PLM is a comprehensive enterprise PLM solution for managing your product value 
chain. 

Audience
This document is intended for administrators and users of the Agile PLM products.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility 
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My 
Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle 
Technology Network (OTN) website 
http://www.oracle.com/technetwork/documentation/agile-085940.html contains 
the latest versions of the Agile PLM PDF files. You can view or download these manuals from 
the Web site, or you can ask your Agile administrator if there is an Agile PLM Documentation 
folder available on your network from which you can access the Agile PLM documentation 
(PDF) files. 

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an 
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which 
you supply particular values.
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monospace Monospace type indicates commands within a paragraph, URLs, code in 
examples, text that appears on the screen, or text that you enter.

Convention Meaning
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1Introduction

The Administration Guide describes how to administrate the installed Agile e6.2.1.0 
components.

About Agile e6.2.1.0 Administration
An Agile e6.2.1.0 application defines a particular hardware and software configuration that 
allows Agile e6.2.1.0 to work with an Oracle database and Oracle WebLogic Server.

To administer the Agile e6.2.1.0 application, you can create and manage Agile e6.2.1.0 
applications. For every created Agile e6.2.1.0 application, information is stored on the EDM 
Server that specifies how to connect to the database, locate data, and which Oracle WebLogic 
Server is to be used.

When you install an EDM Server, the installation program automatically creates a default 
application which is configured during the installation, and the application name is associated 
with the database.

It is also possible to create additional applications within the same installation thus, it is not 
necessary to maintain separate installations for different purposes. A single Agile e6.2.1.0 
installation often includes separate applications for various purposes, such as testing for testing 
purposes before creating the actual working applications, development, production, and 
education.

The applications created for an installation can be associated with the same, or with different 
databases (e.g. a multi-application system, in which development and test applications, and 
their respective databases co-exist with a production application and its database). In general, it 
is required to have a separate production infrastructure to avoid the risk of loss of production by 
changing something in e.g. the development application.

About Agile e6.2.1.0 Business Services Administration
When you create an Agile e6.2.1.0 application, the Business Services component will be 
installed/deployed on your Oracle WebLogic Server for each new application. The Business 
Services comprise of the Workflow Module, Permission Manager, and Product Configurator.

Note: For information about security, please refer to the Security Guide for 
Agile e6.2.1.0.
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Overview of the Workflow Module
To include Workflow processes in an Agile e6.2.1.0 application, optional configuration 
parameters can be defined for the processes within the overall Agile e6.2.1.0 application 
definition. For more information, refer to the chapter Administering Agile e6.2.1.0.

Modifying Configurations without the Administration Client
Any file or configuration modification made without the Administration Client will be lost 
when changing the application values with the Administration client again, except when using 
the component based J2EE installation.

If you want to install/deploy the Agile e6.2.1.0 J2EE components with a separate user, or on a 
separate server, different from the one used for the "native" Agile e6.2.1.0 installation, it is 
necessary to also perform a separate Agile e6 installation of the J2EE components with a 
separate user, or on a separate server.

Note: For further information on using the Workflow module, refer to the 
Agile e6.2.1.0 Online Help > Using Agile e6 > Product Data Management > 
Workflow.
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2Java Application Servers

Oracle WebLogic
The Oracle WebLogic server is mandatory for Agile e6.2.1.0. 

After the Agile e6.2.1.0 installation, the following applications should be available in in one 
WebLogic domain with the default name "eSeries_domain": 

? Web Presentation Service

? Java Client WebStart

? PLM-API (HTTP support)

? Web File Service

? Jvue Applet

? DaemonAdminServlet 

Additionally, for each created application the Business Service and Web Services deployment 
have to be available in one WebLogic domain with default name "eSeries_domain_
<application_name>".

The "eSeries_domain" can be accessed with the following link:

https://app.example.com:7102/console

The "eSeries_domain_<application_name>" can be accessed with the following link:

https://app.example.com:7106/console

To verify the availability of the above deployments, log in to your Oracle WebLogic domains 
and check the following: 

The following applications have to be available in the domain "eSeries_domain":

? Daemon Admin Servlet

? HTTP Support

? Java Client

? JVue

? Streaming File Service

? VueLink

? Web Presentation Service
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? Web Fileservice

The following context roots of these applications should be in working state:

? Daemon Admin Servlet:

https://app.example.com:7104/DaemonAdminServlet/

? HTTP Support:

https://app.example.com:7104/plm-api-axis/services

? Java Client:

https://app.example.com:7104/Jacc/

? JVue:

http://app.dfm.example.com:8040/JVue/

? Streaming Fileservice:

https://app.example.com:7104/StreamingFileService/

? VueLink:

https://app.example.com:7104/VueLink/Vuelink/

? Web Fileservice:

https://app.example.com:7104/FileService/

? Web Presentation Service:

https://app.example.com:7104/AgilePlmWps/

These applications have to be available in the domain "eSeries_domain_
<application_name>":

? Business Service

? Web Services

The following graphic shows the WebLogic deployment architecture after an Agile e6 
installation.

Domains Directory: <MIDDLEWARE_HOME>/user_projects/domains

Note: Use your Oracle WebLogic server name and HTTP port.
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Server Directories: <DOMAIN_HOME>/servers/AdminServer (eSeries-01)

Further information about the Oracle WebLogic server administration can be found under 
Oracle WebLogic Server documentation > Oracle Fusion Middleware Documentation Library:

http://docs.oracle.com/middleware/1221/wls/index.html

Apache Tomcat
Tomcat is only supported for a limited set of deployments for a remote DFM site installation.

The following applications are supported:

? Java Client

? JVue

? Streaming File Service

? VueLink

? Web Fileservice

The following context roots of these applications should be in working state:

? Java Client:

http://app.dfm.example.com:8040/Jacc/

? JVue:

http://app.dfm.example.com:8040/JVue/agile-jvue-wrapper.jar

? Streaming Fileservice:

http://app.dfm.example.com:8040/StreamingFileService/

? VueLink:

http://app.dfm.example.com:8040/VueLink/Vuelink/

? Web Fileservice:

http://app.dfm.example.com:8040/FileService/

The following graphic shows the Remote Site deployment architecture after an Agile e6 
installation.

Note: Use your Apache Tomcat server name and HTTP port.
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3Administering Agile e6.2.1.0

The Agile e6.2.1.0 Administration client lets you create, configure, and delete Agile e6.2.1.0 
applications via the web browser. Agile recommends that you use a supported browser (see 
Prerequisites Guide for Agile e6.2.1.0) to connect to the Administration client.

The Administration Client
The Administration client will be installed automatically with the installer if you install a server 
component. It can be used to create new, or modify existing applications. The Administration 
client is a web based application and is deployed in an Apache Tomcat servlet container. For 
detailed information on Apache Tomcat servlet container refer to:

http://tomcat.apache.org/

Currently we are using Apache Tomcat v8.5.55

In the Agile e6 package, you can find Apache Tomcat in:

? Windows: %ALLUSERSPROFILE%\agile\installer\6.2.1\admin

? UNIX: ${HOME}/.agile/installer/6.2.1/admin.

Starting the Administration Client

Windows:

1. Start the service "AgilePLM_AdminClient".

2. Set the startup type to "Automatically".

UNIX:

1. Use the standard Apache Tomcat startup.

2. Stop scripts.

Note: If you are getting a security message from your browser, you might 
have to add the Administration client to the trusted websites in your browser 
settings.

Note: To prevent sensitive data from being compromised, secure data 
transfer by using HTTPS is recommended. For more information refer to the 
Security Guide. 
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To set the 64-Bit Java 8 for Tomcat on UNIX:

1. Create the file "setenv.sh" in the $HOME/.agile/installer/6.2.1/admin/apache-tomcat/bin 
directory of Tomcat with a line like:

export JAVA_HOME=/usr/local/java/jdk8

2. Tomcat will automatically use this Java version which must point to a 64-bit Java.

3. Start Tomcat with "startup.sh".

4. Stop Tomcat with "shutdown.sh".

Tomcat will show the used Java version at startup with something like:

Using JAVA_HOME: /usr/local/java/jdk8

Changing the Password
The Administration client Password has to be defined after the first startup. Login without 
definition of the password is not possible.

1. Create new encrypted password.

To create a new password, execute:

? Windows:

cd %ALLUSERSPROFILE%\agile\installer\6.2.1
tools\bin\epkeytool.bat -encryptpwd -keyStore 
file://%ALLUSERSPROFILE%/agile/installer/6.2.1/wallets/adminclient/private/
adminclient/cwallet.sso -keyAlias orakey

? UNIX:

cd ${HOME}/.agile/installer/6.2.1/tools/bin
./epkeytool.sh -encryptpwd -keyStore 
file://${HOME}/.agile/installer/6.2.1/wallets/adminclient/private/adminclie
nt/cwallet.sso -keyAlias orakey

The resulting output is your encrypted password.

2. Find encrypted password.

The encrypted password for the Administration client can be found in:

? Windows:

%ALLUSERSPROFILE%\agile\installer\6.2.1\admin\apache-tomcat\webapps\AdminCl
ient\metadata\Adminserver_Props.txt

? UNIX:

$HOME/.agile/installer/6.2.1/admin/apache-tomcat/webapps/AdminClient/metada
ta/Adminserver_Props.txt.

3. Copy the newly generated password into the "Adminserver_Props.txt" file at the password 
property, and restart the Apache Tomcat process.

Note: A 64-bit Java 8 version has to be used.

Note: The password is also stored in the clipboard.
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Changing the WebLogic User Password
The password of the user "weblogic" is used to execute any administrative tasks on a Weblogic 
Server administration console when the Weblogic Server was installed and is in use together 
with Oracle Agile e6?

In this section the placeholder <DOMAIN> is used for:

? eSeries_Domain when talking about the Installation Domain

? eSeries_Domain_<App> when talking about the domain of an application called <App>

Example: 

eSeries_Domain_plmref when talking about the domain of the application "plmref")

<Domain Root> is the installation path to the domains of the Oracle Weblogic Server. When 
installed with Oracle Agile e6 the path looks like this:

Unix: 
/app/plm/product/Middleware/user_projects/domains
Windows:  
C:\PLM\Middleware\user_projects\domains

Adaptions when using the nodemanager

1. Log in to the admin console of the domain <DOMAIN> and check that all servers are in 
"RUNNING" state (if not start them) 

2. In the console on the left (in the domain structure) click "security realms" and select 
"myrealm". On the right, change to the folder "Users and Groups", click user "weblogic" 
and change to the sub folder "Passwords". Insert the new password (twice) and finish by 
clicking "Save".

3. Again, on the left, in the domain structure, click the root object "<DOMAIN>". On the 
right, click the folder "Security" and go down that page and click "Advanced" at the 
bottom: Additional fields are opened further down on that page.

4. In the upper left corner, in the Change Center, click the "Lock and Edit" button

5. Now, on the right, go down to the "NodeManger Password" field and insert the new 
password here and additionally fill the field "Confirm NodeManager Password" with the 
same value. 

6. Go to the Change Center again and click "Activate Changes".

7. Now, stop the eSeries-01 server and then the AdminServer in the admin console.

8. Change the password behind the "password=" tag and add the new value in clear text. in 
both nodemanager boot files of the admin server and of the eSeries-01 server

? <Domain Root>/<DOMAIN>/servers/AdminServer/data/nodemanager/boot.properties

? <Domain Root>/<DOMAIN>/servers/AdminServer/data/nodemanager/boot.properties

? <Domain Root>/<DOMAIN>/servers/eSeries-01/data/nodemanager/boot.properties

Caution: No "non printable" characters like CR or LF are allowed in these 
files!
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9. Finally, restart the servers of that domain through WLST (see note 1439622.1). Be aware 
and use the new password to connect to the node manager now!

10. Log in to the admin console with the new password and check if the servers are up and 
running and all deployments are there and in an active state.

11. Two files with encrypted user credentials per domain are in use for redeployments. 
Therefore these files need to be recreated as well.

1. Create a property file (batch.properties) with the following properties

plm.inst.name=<installation_name>
plm.j2eeappserver.adminserver_
password={PLM-AES-128}RSA-PUBLIC-BASE64:JoQb6W...
plm.application.adminserver_
password={PLM-AES-128}RSA-PUBLIC-BASE64:JoQb6W...

2. Update the file which contains the encrypted password for (re)deployment.

"Installation Domain: setup.cmd j2eeappserver.deploysetup -propertyfile 
properties/batch.properties
"Application Domain: setup.cmd j2eeappserver.deploysetup_app -propertyfile 
properties/batch.properties

12. Adapt all other Weblogic Server Domains accordingly.

Note: If one of the boot.properties files does not exist, then copy that file 
from the same location of the Installation Domain. In this case both the user 
(weblogic) as well as the password have to be entered in clear text into that 
file!

Note: Replace <installation_name> with your installation name (e.g. 
AgileInstallation62).

Note: The encrypted password "plm.j2eeappserver.adminserver_password" 
is the new password for the installation domain and has to be encrypted with 
epkeytool. The encrypted password "plm.applicaton.adminserver_password" 
is the corresponding new password for the application domain.

For further information about the epkeytool please refer to the Security Guide 
for Agile e6.2.1.0.

Note: Make sure to remove the batch.properties file again after changing 
the password.

Caution: If the boot.properties files in the nodemanager directories are 
adapted but the appropriate server is never started with the node manager the 
files stay unchanged and the new password can be read from them as it is still 
there in clear text.

Therefore, after the password changes are finished and all servers are running 
again properly, double check all files called "boot.properties" that none of 
them still contains the new password in clear text.
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Changing the Apache Tomcat Configuration
Tomcat is configured with a HTTP connector by default.

If you want to change this port you have to edit the Apache Tomcat "conf/server.xml" file and 
restart the Apache Tomcat process.

We recommend enabling HTTPs for the Administration client. For more information refer to:

http://tomcat.apache.org/tomcat-8.5-doc/ssl-howto.html

Administering with the Administration Client

Logging In
1. Access the Administration client via

http://<servername>:8080/AdminClient

The login screen opens.

2. Log in with the following parameters:

? User: plm

? Password: Your newly generated password

The Welcome screen is opened.

All available installations that can be configured, appear under Components in the 
navigation pane at the left hand side.

Note: These instructions can be used for one domain only and do not have 
to be processed for all domains of a Weblogic Server installation at the same 
time. However, it is not recommended (and will not be supported) to keep 
different passwords on different domains on the same Weblogic Server. 
Therefore, please update gradually all domains that the passwords of the 
weblogic user match everywhere before you execute further administrative 
tasks on the Oracle Agile e6 installation or on the Weblogic Server itself.

Note: The Administration client uses default ports (e.g. 8080 for the HTTP 
connector).
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Under References, the available Database Connection, Database Server Definition, 
and Application Servers can be found.

Creating/Modifying an Application
1. Under <application name> -> Application, click Create.

The Create new application screen appears.

2. Create a new application with the following parameters:

Application Input Form

Setting Description

Name The name of the default application you want to create.

Database User The database user you want to use for the application.

Database Password The password of the database user.

Verify Password The password entered above has to be repeated for the verification.

WebLogic Server 
Admin Port

The listen port for the WebLogic administration server which will contain the 
WebLogic administration console.
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WebLogic Server 
Admin SSL Port

The SSL listen port for the WebLogic administration server which will contain 
the WebLogic administration console.

Admin Password 
Application Domain

The password of the WebLogic user used for the application domain.

Confirm Admin 
Password Application 
Domain

The password entered above has to be repeated for verification.

WebLogic Server 
eSeries Port

The listen port for the WebLogic EDM server. The installer will create a 
separate managed server with the name "eSeries-01" in addition to the 
administration server. This server will contain the application specific 
deployments.

WebLogic Server 
eSeries SSL Port

The SSL listen port for the WebLogic EDM server. The installer will create a 
separate managed server with the name "eSeries-01" in addition to the 
administration server. This server will contain the application specific 
deployments.

J2EE Host The host on which Business and/or Web Services are running.

The WebLogic server host name.

Http Host The host where the Web Client can be reached over HTTP.

The WebLogic server host name.

Http Port The port where the Web Client can be reached over HTTP.

The HTTP port of WebLogic server.

Business Service ECI 
Port

The port where the Business Service will be configured to "wait" for requests.

Web Services ECI Port The port where the Web Services will be configured to "wait" for requests.

Workflow Admin UIC The UIC of an Agile e6 user who has administrative rights for the Workflow 
module. He will receive mails about administrative problems in the Workflow 
module (1000 - 99999).

This user needs a valid e-mail address as a test e-mail is send when starting the 
Messenger. The messenger does not work at all if this email is missing or 
wrong!

Mail Server The name of your SMTP mail server if you want to send emails via the 
Business Services. Mailing will be disabled if no host name is set.

Mail Port Number The port number of your SMTP mail server if you want to send emails via the 
Business Services. (587 is the submission port for using encryption. 25 is the 
old standard SMTP port).

Mail Security Choose the security of your mail server (STARTTLS or SSL/TLS)

SMTP User Name User name for your SMTP mail server.

SMTP User Password SMTP User Password for your SMTP mail server. 

Password must be encrypted, plain text will not be accepted

Confirm Mail Auth 
Password

The password entered above has to be repeated for verification.

Import DB Dump Select if you want the standard dump to be imported to the above defined 
database user.

Create DB User Select if you want the database user to be created automatically.

SYSTEM Password Password of the Oracle database user.

Note: You only have to supply a value here if you want to create a new 
database user and have selected this in the field above.

Setting Description
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References

In the References section you can define which database and application server must be 
used for this application. Normally, you don't have to change these values.

3. Click Create.

Updating an Application
1. To update an application click Application > Modify <application name>.

2. Click "Edit" in the upper right corner to be able to change the values for the application.

3. Change the necessary values.

PLM Authenticator 
Password

Password of the WebLogic user PlmAuthenticatorDSUser, which secures the 
Data Source PlmAuthenticatorDS used by the PLM Authentication provider.

Confirm PLM 
Authenticator Password

The password entered above has to be repeated for verification.

Plm 'manager' 
password

If you selected "Import DB Dump", apply the password which the plm 
'manager' user of the created application should have.

Verify Password If you selected "Import DB Dump", the password entered above has to be 
repeated for verification

Setting Description

Application Server The name of the reference of the Oracle WebLogic Server where Web Services 
and Business Service will be deployed.

Database The name of the reference of the database you want to use for the application.

Note: Creating a new application can take up to 20 minutes. If a database 
user will be created, the database dump for the application has to be 
imported, the domain created and setup.

Note: In case you receive the error "The connection has timed out", please 
check if the new application is installed correctly. 

1. Open the directory with the installer log files, which can be found in the 
following locations:

? Windows

%ALLUSERSPROFILE%\agile\installer\6.2.1\l
og

? UNIX

${HOME}/.agile/installer/6.2.1/log

2. Please check for the file install_error.log in all sub-directories starting with the 
timestamp approximately of the beginning of your installation.

If the install_error.log cannot be found in these sub-directories, the 
installation is completed. You can check if the newly created installation 
can be found in the navigation of the Administration Client.

Setting Description
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4. To apply the changes, click "Update" in the upper right corner.

The Admin server will redeploy the Web Services and Business Services for this 
application with the new values.

Deleting an Application
It is possible to delete the application with the "Delete" button in the upper right corner.

Adding a New Database Reference for an Application
To use a new database for an application, the following components are required:

? Valid database connection string.

? Valid definition of a database used by a database connection.

? Running SQL Net.

To create a new database connection:

1. In the left pane, under References > Database Connection click Create.

The Create new database connection screen appears:

2. Create a new database connection with the following parameters:

3. Click Create in the upper right corner.

Note: It is NOT recommended updating a production application that is in 
use and running.

Note: Deleting an application will not remove the domain for Web 
Services/Business Service from the Oracle WebLogic Server. This must be 
done manually. 

Refer to the support note "How to Remove/Delete a Weblogic Server (WLS) 
Domain (Doc ID 1068323.1)" on My Oracle Support. 

Also, the used database schema remains unchanged.

Setting Description

Name The new name which identifies the connection.

Client Home The Oracle Client Home directory.

SQLNet Connect The SQLNet connect string as defined in e.g. tnsnames.ora.

https://support.oracle.com/epmos/faces/DocContentDisplay?id=1068323.1
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To define a new database server:

1. In the left pane, under References > Database Connection, click Create.

The Create new database definition screen appears:

2. 2. Create a new database server with the following parameters:

3. Under References, define a database connection.

The database connection, which is used to connect to the database in reference section.

4. Click Create in the upper right corner.

Adding a New Application Server Reference for an Application
1. In the left pane, under References > Application Server click Create.

The Create new application server definition screen appears:

2. Define a new application server with the following parameters:

Setting Description

Name The new name which identifies the database definition.

Host Name The host name of your database server.

SID The SID of the database you want to connect to.

Port The port where the listener listens on the database server.
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3. Click "Create" in the upper right corner.

Deleting a Reference
1. In the left pane, expand the "Modify" node of either:

? Reference > Database Connection

? Reference > Database Server Definition

? Reference > Application Server

2. Select the name of the reference.

3. Click "Delete" in the upper left corner.

Logging Out
1. 1. To log out click the "Logout" link in the upper left corner.

Setting and Changing Initial User Passwords in a New Agile 
e6.2.1.0 Application

Perform the following steps:

1. Start an Agile e6.2.1.0 client and log in to your application with the user "manager". The 
password of the "manager" user is the one you applied during installation, 
applicationcreation.

2. All other users are deactivated and have to be activated by setting a new valid password for 
them.

Setting Description

Name The new name which identifies the Oracle WebLogic server 
definition.

Oracle Home 
(WebLogic)

The Oracle Home directory where WebLogic is installed (e.g.: 
D:\Oracle\Middleware\Oracle_Home).

Domain Root The root directory where the Agile e6 WebLogic domains should be 
created (e.g.: D:\Oracle\Middleware\Oracle_Home\user_
projects\domains).

In this directory the installer will create all domains used by the Agile 
e6 J2EE components.

Note: This will only delete the reference in the "installation_prop.xml" file 
if the reference is not in use. If it is in use, an error message is displayed.

Nothing else will be deleted.

Note: The Administration client times out after 10 minutes. This requires a 
re-log in.

Note: The enhanced security module is enabled in each newly created 
application (with a new dump) by default. You can only log in to this 
application with the user "manager"!
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Set the password for user "EDBCUSTO" and all other standard users:

1. Start Agile e6.

2. Open menu Manager > Permissions > User > Basic Data.

3. To set the password, click Refresh.

4. Select user "EDBCUSTO".

5. Open the context menu and select Set Password.

6. Repeat these steps for all newly created users and standard users.

Note: At the first log in of user "EDBCUSTO" with the initial password, 
the user will be asked to set a new password. This will be the password for 
future logins.

Note: Further information about the user management can be found in the 
Online Help > Customizing Agile e6 > Data View > Data View User's Guide 
> Users, Groups and Privileges.
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Deploying Customer Adapted Files
Customer adapted files which are part of a deployment, have to be adapted outside the 
WebLogic server. The same applies for the Tomcat application server for a DFM remote site 
installation. These adapted files will be available even after applying a hotfix.

The deployment process in Agile e6 will create a "staging" directory in <ep_root> with four 
subdirectories and is active for all described batch deployment tasks.

All four subdirectories contain an "installation" directory for all application-independent 
deployments and an "application" directory containing an additional subdirectory for each 
Agile e6 application. This subdirectory contains the application specific deployments (e.g. the 
BusinessService).

? product:

This directory contains a subdirectory for every deployed component. Under these 
subdirectories, the unzipped archives are available. If you want to modify any file in the 
archive, the file has to be copied to the same directory in the "custom" folder.

? custom:

This directory contains the same directory structure as the "product" folder without files 
(except one, see Adapting Business Service Notification Mail Templates). Copy the files 
you want to modify from the "product" folder to the corresponding directory in this folder.

Note: We do not support the changing of Agile e6 files directly in the 
Oracle WebLogic server deployment.

The same applies for the Tomcat application server for a DFM remote site 
installation.

Note: When redeploying, changes made in this directory and its 
subdirectories will be lost.

Note: This is the ONLY folder where you should make changes to files and 
add directories.
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? merged:

This directory contains the merged result of the "product" and "custom" folders. In this 
directory structure you can check if your adapted files are available in the unzipped 
archive.

From this directory structure, the final archive will be created in the deploy directory.

? deploy:

This directory contains the final archive before it will be deployed.

Keeping Customer Adapted Files When Deploying a Hotfix
If you are installing a hotfix, you might get updates for files you have adapted in the past.

To keep the adaptations, do the following:

1. Check for changes in the readme file of the hotfix package.

2. Backup your "product" folder.

3. Install the hotfix.

4. Compare the backup of the "product" folder with the new "product" folder to identify any 
files which have been changed.

5. If you have modified any of these files in the "custom" folder, then apply the changes to 
the files in the "product" folder manually.

6. Redeploy the application to activate the changes.

Administrating the Business Service
Business Services are always deployed if a new application is created with the Administration 
client. Therefore, the availability of the application server is mandatory.

If you want to perform additional changes to the Workflow module, you have to edit the 
configuration file for the Business Services.

To modify the configuration file, you have to perform the steps described in the section 
Deploying Customer Adapted Files of this document.

Example: Adapt values in "ABS_<application_name>.ini" file of the Business Service.

Note: Files cannot be deleted from the "product" folder by copying them to 
the "custom" folder, and deleting them there.

Note: When redeploying, changes made in this directory and its 
subdirectories will be lost.

Note: When redeploying, changes made in this directory and its 
subdirectories will be lost.

Note: For further information about the Workflow module, please refer to 
the Workflow Online Help.
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To modify the configuration file, it can be copied from the "product" directory after the 
installation. The file is available under: "<ep_root>\staging\product\application\<application_
name>\BusinessService\BusinessService.war\WEB-INF\classes".

Save the modified file to the folder:

"<ep_root>\staging\custom\application\<application_
name>\BusinessService\BusinessService.war\WEB-INF\classes".

The file that you modified will be used with the next deployment of the Business Service.

The Business Services will connect to the defined database user/schema directly after they are 
started in the Oracle WebLogic server.

Adapting Business Service Notification Mail Templates
After the first Business Service deployment of a new application, the notification mail 
templates are unpacked and available under:

"<ep_root>\staging\custom\application\<application_
name>\BusinessService\BusinessService.war\WEB-INF\lib\abs-notifier-templates\lay\notifier"

All adaptations made to files in this directory, also all new files, will be available after the next 
deployment of the Business Service. All files and directories below the "abs-notifier-templates" 
directory will be automatically packed to "abs-notifier-templates-1.0-SNAPSHOT.jar" file, 
which will be used for the deployment.

Connection Pool for Business Service
For WebLogic, default settings are available for the data source definition and can be 
customized. To customize them, the following template file has to be edited:

%EP_ROOT%\build\applicationServer\weblogic_122\tpl_app\ear\tpl_
eSeriesDataSource-jdbc.xml

Example for default values for the connection pool:
<jdbc-connection-pool-params>
<pinned-to-thread>true</pinned-to-thread>
<initial-capacity>5</initial-capacity>
<max-capacity>150</max-capacity>
<statement-cache-size>100</statement-cache-size>
<statement-cache-type>LRU</statement-cache-type>
<connection-reserve-timeout-seconds>120</connection-reserve-timeout-seconds>
<test-table-name>SQL SELECT 1 FROM DUAL</test-table-name>

Note: Once this connection is lost, e.g. due to database reboot, due to 
dropping of the database schema, or due to loss of service, you must restart 
the Business Service inside the Oracle WebLogic server.

Note: It is also possible to restart the complete Oracle WebLogic server, but 
all the included services will not be available for that time.

Note: For further information about WebLogic, please refer to the 
respective documentation: 
http://docs.oracle.com/middleware/1221/wls/JDBCP/ds_
annotation.htm
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</jdbc-connection-pool-params>

About PLM-API / HTTPS Support

PLM-API allows the communication with the Agile e6.2.1.0 application server through 
firewalls (via HTTPS).

For further information on the architecture, refer to the Architecture Guide for Agile e6.2.1.0.

The PLM-API is always deployed if a new Agile e6.2.1.0 server installation is created and can 
be used for all created applications of the installation. To be able to use the PLM-API, it has to 
be configured in the Java Client. To use the PLM-API, The WebLogic server needs to be setup 
for HTTPS usage. Detailed information how to configure the WebLogic Server can be found in 
the WebLogic Server documentation on the Oracle Technology Network 
(http://www.oracle.com/technetwork/index.html).

For further information on how to set up the HTTPS support in the Java Client, refer to the 
section Online Help > Getting Started > Preferences, and the Architecture Guide for Agile 
e6.2.1.0.

Special Batch Administration Tasks

Prerequisites

For all batch tasks set the JAVA_HOME environment variable to Java 8 64-bit JDK before you 
execute setup.cmd/setup.csh in a cmd/csh shell.

Use the installation user of the Agile e6.2.1.0 installation.

Note: When configuring the minimum/maximum number of connections 
(<initial-capacity>), every connection needs a database process. Thus, the 
database has to have enough processes. Please check the configuration values 
in file: tpl_eSeriesDataSource-jdbc.xml and refer to your database 
administrator for further details.

Note: Further information about how to increase the performance can be 
obtained in an Oracle WebLogic training session.

Note: Only supported with the Java Client.

Note: Agile e6.2.1.0 has to be installed!

Windows UNIX

Use an administrator cmd shell. Use a csh shell.

Execute setup.cmd for all batch tasks in:

%ALLUSERSPROFILE%\agile\installer\6.2.1

Execute setup.csh for all batch tasks in:

${HOME}/.agile/installer/6.2.1
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A properties file ("batch.properties") has to be created in one of the following directories by 
making a copy of the tpl_installation.properties file and adapting the properties in it:

Example:

Create an Application
1. Copy the template properties file installer/properties/tpl_installation.properties to 

installer/properties/batch.properties.

2. Replace the text in brackets (<CHANGETHIS>) with the values of your application.

You can use different batch properties files for each application.

# Defines if the schema will be created (system password also has to be applied 
for creating a schema)
plm.application.creschema=true
# Defines if the content of an existing schema will be deleted (Attention: All 
objects of the defined schema will be lost)?
plm.application.delschemaobj=false
# Database to import as defined in installation_prop.xml (normally no need to 
change this)
plm.application.databasedefinition=oradb
plm.oracle.systempwd=<systempwd>

3. After defining the properties, execute (example):

setup.cmd application.install -propertyfile properties/batch.properties > 
application_install.log 2>&1
This will create the application directory and the configuration files in the <ep_root>/init 
directory. Additionally, if enabled, the schema will be created and the reference dump will 
be imported.

To deploy the J2EE applications for an Agile e6 application, the following additional steps need 
to be executed.

1. Create J2EE application domain (example):

Windows UNIX

%ALLUSERSPROFILE%\agile\installer\6.2.1
\properties

${HOME}/.agile/installer/6.2.1/properties

Windows UNIX

cd 
%ALLUSERSPROFILE%\agile\installer\6. 
2.0
set JAVA_HOME=<java8_64bit_home>
setup.cmd application.install 
-propertyfile 
properties\batch.properties > batch_ 
install.log 2>&1

cd ${HOME}/.agile/installer/6.2.1
setenv JAVA_HOME <java8_64bit_home>
./setup.csh application.install 
-propertyfile  
properties/batch.properties >& 
batch_install.log

Note: On UNIX, use different redirector settings for stderr and stdout

Note: After each batch installation task, check the log file.
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setup.cmd j2eeappserver.install.domain_app -propertyfile 
properties/batch.properties > install_domain_app.log 2>&1

2. Deploy J2EE applications (Business Service, Web Services) to domain (example):

setup.cmd j2eeappserver.deploy.app -propertyfile properties/batch.properties > 
deploy_app.log 2>&1

Set Manager User Password
Use this ant task to set the plm manager user password of an existing application. This will 
overwrite current password of the plm manager user in the database.

1. Create a properties file "properties/batch.properties" with following properties (example):

plm.inst.name=AgileInstallation
plm.application.name=plmref
plm.application.managerpassword={PLM-AES-128}RSA-PUBLIC-BASE64:O/NCRL5LUX....

2. Execute:

setup.cmd application.setmanagerpassword -propertyfile 
properties/batch.properties

Common Properties for the Redeployment
Each of the following redeployment tasks requires a property file with at least the following 
content.

1. Create a common Properties file (example):

plm.inst.name=<installation_name>

(Re)Deploying Business Services for an Application
Redeploying a Business Service causes a recreation of the Business Service 'ear' file and the 
deployment with the configured values as defined in the installation_prop.xml file.

1. Add the following lines to the common properties file (example):

plm.application.name=mytest
plm.application.dbpassword={PLM-AES-128}RSA-PUBLIC-BASE64:JoQb6W...

Note: For more information about encrypting the Manager password with 
the Agile EDM Server Wallet refer to the Agile EDM Security Guide Chapter 
4 Encryption > Encrypt Passwords. 

 General information about the Wallets can be found in the Agile EDM 
Security Guide Chapter 3 Wallets > Overview Wallet Infrastructure.

Note: Replace <installation_name> with your installation name (e.g. 
AgileInstallation62).

Note: The following three deployment tasks require additional properties:

? Business Service

? Web Services

? Web Development Toolkit
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2. Redeploy BusinessService (example):

setup.cmd j2eeappserver.deploy.businessservice -propertyfile 
properties/batch.properties > deploy_businessservice.log 2>&1

(Re)Deploying Web Services for an Application
1. Add the following line to the common properties file (example):

plm.application.name=mytest
2. Redeploy the Web Service (example):

setup.cmd j2eeappserver.deploy.webservices.core -propertyfile 
properties/batch.properties > deploy_webservices.log 2>&1

(Re)Deploying Web Development Toolkit
Web Development Toolkit is not deployed after default installation. If you want to use it, you 
have to deploy it first.

1. Add the following line to the common properties file (example):

j2eeappserver.deploy.webdevelopmenttoolkit=true
2. Redeploy (example):

setup.cmd j2eeappserver.deploy.webdevelopmenttoolkit -propertyfile 
properties/batch.properties > deploy_wdt.log 2>&1

(Re)Deploying Java Client
1. Redeploy (example):

setup.cmd j2eeappserver.deploy.javaclient -propertyfile 
properties/batch.properties > deploy_javaclient.log 2>&1

(Re)Deploying Web Presentation Service
1. Redeploy (example):

setup.cmd j2eeappserver.deploy.webpresentationservice -propertyfile 
properties/batch.properties > deploy_wps.log 2>&1

(Re)Deploying HTTPSupport (plm-api)
1. Redeploy (example):

setup.cmd j2eeappserver.deploy.httpsupport -propertyfile 
properties/batch.properties > deploy_httpsupport.log 2>&1

Note: The encrypted password "plm.application.dbpassword" is the 
database schema password for this application and has to be encrypted with 
epkeytool.

For further information about the epkeytool please refer to the Security Guide 
for Agile e6.2.1.0.

Note: This can also be used to redeploy the Web Development Toolkit.
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(Re)Deploying Web Fileservice
1. Redeploy (example):

setup.cmd j2eeappserver.deploy.webfileservice -propertyfile 
properties/batch.properties > deploy_wfs.log 2>&1

(Re)Deploying StreamingFileservices
1. Redeploy (example):

setup.cmd j2eeappserver.deploy.fileservices -propertyfile 
properties/batch.properties > deploy_sfs.log 2>&1

(Re)Deploying JVue (Agile e6 AutoVue Integration Client Component)
1. Redeploy (example):

setup.cmd j2eeappserver.deploy.jvue -propertyfile properties/batch.properties > 
deploy_jvue.log 2>&1

(Re)Deploying Vuelink (Agile e6 AutoVue Integration Server 
Component)

1. Redeploy (example):

setup.cmd j2eeappserver.deploy.vuelink -propertyfile 
properties/batch.properties > deploy_vuelink.log 2>&1

(Re)Deploying DaemonAdminServlet
1. Redeploy (example):

setup.cmd j2eeappserver.deploy.daemonadminservlet -propertyfile 
properties/batch.properties > deploy_admsvlt.log 2>&1

Use DB Sequences for C_ID Generation
You can replace the standard random based DataView algorithm for generating C_ID with an 
algorithm based on database sequences. The mechanism was previously used for environments 
with database replications only.

The algorithm uses a database sequence to generate the next free C_ID number. Every table 
uses an distinct db sequence with name <table_name>_SEQ.

To avoids conflicts with already existing C_IDs the values need to be between 01 and 1 Billion 
(minimum value 1 - maximum value 1 billion. As a standard, DataView uses the value range 
from 1 billion to 2 billion. 

Note: When redeploying the VueLink, you need to reopen any AutoVue 
window and restart the AutoVue Metafile Cache Service. 

Note: The Workflow still creates the C_ID by normal random algorithm 
between 1 billion and 2 billion.
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Initial setup of your environment to use C_ID generation based on Database 
Sequences

1. Activate Library by opening the file ep_root\init\<application_name>.xml and 
uncommenting the following in the <Modules>: 

<Custom>
 <cid_by_seq  Name="CID by Sequence" Library="cid_by_seq" Startup="immediately" 
/>
 </Custom>

2. Create DB stored function in your oracle dump

1. Start sql plus as db user of your e6 application in the directory where you have  stored 
the sql script to create the db procedure (axalant\db_util\oracle\sql)

2. Execute the SQLPLUS> @dbs_cid_by_seq.sql

3. Create sequences for all tables containing a column C_ID. Available range of C_ID's is 
from 01 to 1 Billion.

1.  Start sql plus in the directory where you have stored the sql script to create all 
sequences (axalant\db_util\oracle\sql)

2.  Execute script dbs_cre_seq_all.sql

3. Type in values for Start Value and Max value.

The script generates a sql scripts dbs_cre_seq_all_run.sql containing statements to 
drop existing sequences for c_id generation and statements to created new sequences 
with the start and maximum values as defined

4. You are then prompted to either 

Continue with <ENTER> - executes the newly generated script directly

Abort with <CTRL C> - review the generated script first and if necessary adapt the 
script. The script needs to be execute separately in sqlplus. 

4. To check, if the new algorithm works correctly, do the following: 

? Log-into e6

? Activate SQL-Trace

Note: Do not activate the module in both files (axalant.xml and 
<application-name>.xml) otherwise the application cannot be started.

Note: Module name "cid_by_seq" must be written in lower case characters.
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? Insert  a document and check in the generated trace file which C_ID was generated 
(search for insert into t_doc_dat)

Configure new tables with c_id generation based on DB Sequences

If you create a new table using DataView the necessary sequence for this table will not be 
created automatically! You have to create the sequence manual using the SQL-Scripts dbs_cre_
seq_one.sql (input parameters: start value, max value, table name). The scripts follow the same 
process as described above in the initial setup, but one additional input parameter is added - the 
table _name for which the sequence should be created.

1. Start sql plus in the directory where you have stored the sql script to create the db 
procedure (axalant\db_util\oracle\sql)

2. Execute the scripts as follows: 

Caution: If no sequence exists, the old generation from dtv method will be 
used!
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5Cluster Setup for Servers

We support two general ways to deploy Agile e6 software

1. One single J2EE Server on a separate node, hosting the WebLogic and all J2EE 
components for Agile e6, and an additional set of servers, hosting the native Agile e6 
components.

2. A set of servers of which every server hosts a complete set of all Agile e6 server 
components - J2EE and native components. The nodes are installed in a cluster, e.g. as 
NLB cluster, and load balancing tools are used to distribute the load to the servers.

One J2EE Server on a Separate Node
The server having the Agile e6 J2EE components installed - the WebLogic server - is separated 
from the server with the native Agile e6 components - the EDM server.

We highly recommend setting up two WebLogic servers on separate nodes as failover. The 
server, which will run from beginning, is called the WebLogic node. The second WebLogic 
node remains inactive as failover server until the main WebLogic server stops working.

Installation
1. Install the WebLogic server nodes.

2. After completing the installation, stop the failover application server on the failover node.

3. After completing the application server installation, install the EDM systems on separate 
nodes.

4. Configure each of them for the main application server node.

Note: For further information, please refer to the Architecture Guide for 
Agile e6.2.1.0.

Note: For further information, please refer to chapter Component Based 
Installation in Server Installation Guide on Windows and UNIX for Agile 
e6.2.1.0.

Note: Make sure it does not start automatically, e.g. by self-customized 
scripts.
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Prepare Failover Configuration in Case of Errors
1. After completing the installation, for each EDM system, copy the application configuration 

file <ep_root>/init/<application-name>.xml and rename it to e.g. 
<application-name>-failover.xml.

2. Edit the renamed file and change the application server entry to mention the failover node 
with the failover application server.

Example:

<IPC AbsEciUrl="eci://localhost:19997" .... </IPC>

In Case of Errors:

1. If the main application server stops and cannot be restarted, start the failover application 
server on the failover node.

2. Switch to the failover configuration for each EDM system.

1. Stop the EDM system.

2. Rename the original configuration file <ep_root>/init/<application-name>.xml to e.g. 
<application-name>_org.xml.

3. Rename the backup configuration file <application-name>_failover.xml to 
<application-name>.xml

4. Start the EDM system.

Note: This file will be used!
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Several Application Servers are Active
The 2nd scenario is for a load-balanced cluster with installations of the native Agile e6 
components and the WebLogic servers on all nodes. In this case, the Watchdog of the Workflow 
services can only run on one application server. All other Agile e6 J2EE components use the 
load balancing feature. This includes the cache of the permission managers which will be 
synchronized over all cluster nodes. After a successful Agile e6 installation, the Watchdog 
needs to be deactivated on all servers where it is not required, as described below.

Deactivation and Failover for the Workflow Watchdog

1. Install WebLogic Server and EDM Server on all Nodes.

2. Define the node for the active Workflow services.

3. Edit the file "ABS_<application-name>.ini" for all other node(s).

4. Search for:

ServiceManager\Nodes\localhost\Threads\K]
className=com.agile.abs.workflow.watchdog.WatchdogService
localThread=true

And change it to (comment it):

#[ServiceManager\Nodes\localhost\Threads\K]
#className=com.agile.abs.workflow.watchdog.WatchdogService
#localThread=true

5. Redeploy all changed applications.

In Case of Errors:

1. If the main application server with the active Workflow service stops and cannot be 
restarted, remove the commenting in the file "ABS_<application-name>.ini" for one of the 
other nodes.

Note: The switch to the backup application server is done.

Note: Further information about the installation can be found in the 
respective installation manuals for Agile e6.2.1.0.
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2. Redeploy the changed application.

Manage Synchronization between Permission Manager Instances
In case several permission managers are used, their cache can be automatically synchronized 
after a defined time period. The synchronization parameters can be configured in "ABS_
<application-name>.ini for every node.

#activate permission manager cache

#activate permission manager cache, missing entry or true = activated caching, 
false = deactivated caching

The prmPeriod defines the time between two checks of the prm time stamp on the data base. If 
something relevant happened for permission manager in that period, the prm time stamp was 
changed on database.

#max object size of the permission manager cache 

The cache size could be calculated for example like this: 

(users + groups + roles + jobs + tasks) * 0.75

Example: 

prmCacheSize=5001

Note: The switch to another application server with an active Workflow 
services is completed.

(missing entry) If prmCache entry is missing in 
the ABS...ini file, the cache is 
activated by default.

true Activate caching (default) prmCache=true

false Disable caching prmCache=false

(missing entry) Uses the default of 10 minutes

prmPeriod=0:10 The value is formatted in 
hours:minutes (Format: hh:mm).

Note: After the update, the changed application has to be redeployed.
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6RAC Support

This section describes necessary modifications of an Agile e6.2.1.0 installation, including 
deployed Business Services, to support a RAC database.

We recommend performing the RAC database setup, and Agile e6.2.1.0 adaptations with the 
help of an Oracle consultant.

Prerequisites
1. RAC database is running.

Oracle consulting has reviewed and approved the RAC database installation.

2. Necessary changes in tnsnames.ora and sqlnet.ora on the Oracle client side, where the 
EDM server is running, are carried out.

3. Oracle WebLogic server is installed and running.

4. Follow the installation instruction for Agile e6.2.1.0 as described in the Server Installation 
Guide on Windows and UNIX for Agile e6.2.1.0.

5. For the RAC support, the following needs to be changed:

? In the "Reference Configuration" mask you have to provide the following entries:

– As "SQLNet Connect" add the net alias for your RAC database in tnsnames.ora.

– As SID select the SID of one of the instances of your RAC database.

– As "Host Name" add the IP address/hostname where this instance is running.

The following screenshot shows an example configuration.

Note: For more information about RAC architecture, please see also the 
Architecture Guide for Agile e6.2.1.0
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6. Continue the installation instruction for Agile e6.2.1.0 as described in the Server 
Installation Guide on Windows and UNIX for Agile e6.2.1.0.

7. Please adapt the configuration for the data source definition to benefit from the Fast 
Connection Failover (FCF) feature.

If an instance is down, the J2EE components will continue to work normally using any 
other available instance of the RAC database.

8. Copy the original file from the "product" folder to the related "custom" folder:

<ep_root>/staging/product/application/<application_
name>/BusinessService/META-INF/eSeriesDataSource_<application_name>.xml

To:

<ep_root>/staging/custom/application/<application_
name>/BusinessService/META-INF/eSeriesDataSource_<application_name>.xml

9. Change the file as shown in this example.

<name>eSeriesDataSource_yin_app</name>
<jdbc-driver-params>
  <url>jdbc:oracle:thin:@rac-scan.example.com:1521/plm62</url>
  <driver-name>oracle.jdbc.pool.OracleDataSource</driver-name>
  <properties>
    <property>
      <name>user</name>
      <value>plm62</value>
    </property>
    <property>
      <name>FastConnectionFailoverEnabled</name>
      <value>true</value>
    </property>
    <property>
      <name>ConnectionCachingEnabled</name>
      <value>true</value>
    </property>

Note: Please review the process described in chapter Deploying Customer 
Adapted Files.
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  </properties>
  <password-encrypted>XXX</password-encrypted>
</jdbc-driver-params>
<jdbc-connection-pool-params>
  <initial-capacity>5</initial-capacity>
  <max-capacity>100</max-capacity>
  <connection-reserve-timeout-seconds>10</connection-reserve-timeout-seconds>
  
<inactive-connection-timeout-seconds>1800</inactive-connection-timeout-seconds>
  <test-table-name>SQL SELECT 1 FROM DUAL</test-table-name>
</jdbc-connection-pool-params>
<jdbc-data-source-params>
  <jndi-name>eSeriesDataSource_yin_app</jndi-name>
  <global-transactions-protocol>OnePhaseCommit</global-transactions-protocol>
  <scope>Application</scope>
</jdbc-data-source-params>
<jdbc-oracle-params>
  <fan-enabled>true</fan-enabled>
  <ons-node-list>db1.example.com:6200,db2.example.com:6200
  </ons-node-list>
</jdbc-oracle-params>

10. Redeploy Business Service.

Limitation
The Agile e6 Configurator application uses a special connection which connects only to the 
instance provided in the "Reference Configuration" mask. If this instance is down, then the 
Configurator will not work anymore. If you use the Configurator, you must adapt the 
connection information for the Configurator to connect to a running database instance.

Note: This limitation is only valid for the Agile e6 Configurator. All other 
applications (e.g. Workflow, Permission Manager) support the RAC database.
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7Java Client

Predefined Java Client Connection Settings
When starting the Agile e6 Client, the following connection settings can be passed:

-a <Application Name>
-h <Host Name>
-d <Daemon number>
-p <ECI port>
-u <PLM Username>
-l <logintype>
-f <flag for login dialog>
-t <task>
-home <home directory>
-imageRoot <url>
-imageDir <dir>
-defaults <file|URL>

Java Client Native Installation Windows example:

1. Open properties for the shortcut "Agile e6.1 Java Client.lnk" in "C:\Documents and 
Settings\All Users\Start Menu\Programs\"

2. At the end of the "Target" attribute, add the connection setting you want to use e.g.:

-a plmref -h example.com
3. It is also possible to edit the "jacc.cmd" file in "C:\Documents and Settings\All 

Users\Application Data\Oracle\Agile\EDM" and to add the setting there. Search for the 
line which ends with

…com.agile.jacc.e6.Jacc %*"

and replace this with e.g.:

"…com.agile.jacc.e6.Jacc %* -a < Application Name > -h <Host name>…"

Example - Java Client WebStart:

1. If not yet available, copy

"<ep_root>\staging\product\installation\JavaClient\jacc.defaults"

to

"<ep_root>\staging\custom\installation\JavaClient\jacc.defaults"

2. Adapt the properties you need in 
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"<ep_root>\staging\custom\installation\JavaClient\jacc.defaults":

jacc.node, jacc.port, jacc.app

Compression Option (WAN only)

To improve the data transfer performance when loading data via WAN, the Java Client 
Advanced IPC settings compression option 'jacc.ipc.compressSize' can be set. 

For more information on the Java Client jacc.ipc.compressSize option refer to the Online Help 
Customizing Agile e6 > Enterprise Communication Interface (ECI) > IPC Interface > 
Connection Type "tcpip" > Compression.

Java Client Remote Site Definition
The client variable EP_DDM_SITE is used to configure the DFM client location. In addition, 
the system allows configuring the client location for the Agile e6 AutoVue Integration - EP_
PVM_SITE.

To configure the Java Client to start with a specific DFM/PVM site, you have several options.

Configure Local Installed Java Client
1. Edit the file "jacc.cmd" in "C:\Documents and Settings\All Users\Application 

Data\Oracle\Agile\EDM" and to add the setting there, search for the line where "javaw" is 
executed and add e.g.: -DEP_DDM_SITE="ka" (for AutoVue: -DEP_PVM_SITE="ka"). 
The line looks like:

""%JAVA_HOME%\bin\javaw.exe" %VM_OPTS% -Djacc.home="$APPDATA\e61" -DEP_DDM_
SITE="mu" (for AutoVue: -DEP_PVM_SITE="mu" )…."

OR

1. Add the following to file jacc.ini in $APPDATA\Agile\e61\:

? EP_DDM_SITE=de

? For AutoVue: EP_PVM_SITE=de

For example:

"C:\Documents and Settings\<username>\Application Data\Agile\e61\jacc.ini.

The jacc.ini file is available after the first execution of the Java Client.

OR

Note: For more information about EP_PVM_SITE, see the AutoVue 
Integration Installation and Administration Guide for Agile e6.2.1.0 (Chapter: 
Configuring Multiple Location Support).

Note: The PVM configuration only needs to be performed when using the 
Agile e6 AutoVue Integration.

Note: Do not edit the file while the client is running, or your settings will 
be overwritten.
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1. Set the environment variable EP_DDM_SITE=de (for AutoVue: EP_PVM_SITE=de) on 
the client machine application.

Configure WebStart Java Client
1. If not yet available, copy "<ep_root>\staging\product\installation\JavaClient\jacc.defaults" 

to "<ep_root>\staging\custom\installation\JavaClient\jacc.defaults".

2. Open "<ep_root>\staging\custom\installation\JavaClient\jacc.defaults" and change the 
lines:

? EP_DDM_SITE=de

? For AutoVue: EP_PVM_SITE=de

3. Deploy the WebStart Java Client.

OR

4. Set the environment variable EP_DDM_SITE=de (and/or for AutoVue: EP_PVM_
SITE=de) on the client machine application.

Configure WebStart Java Client for Multiple Remote Locations
As described, it is possible to setup the EP_DDM_SITE, and for AutoVue EP_PVM_SITE, in 
the jacc.defaults file within the WebStart Java Client deployment. If more locations should use 
the central WebStart Java Client deployment, a different EP_DDM_SITE (and for AutoVue: 
EP_PVM_SITE) configuration has to exist in the same deployment.

In the following example, the EP_DDM_SITE (and for AutoVue: EP_PVM_SITE) are "de" 
and "us".

1. If not yet available, copy 

"<ep_root>\staging\product\installation\JavaClient\jacc.defaults" 

to 

"<ep_root>\staging\custom\installation\JavaClient\jacc_de.defaults".

2. Open "<ep_root>\staging\custom\installation\JavaClient\jacc_de.defaults" and change the 
EP_DDM_SITE to EP_DDM_SITE=de (and for AutoVue: EP_PVM_SITE to EP_PVM_
SITE=de).

3. If not yet available, copy 

"<ep_root>\staging\product\installation\JavaClient\jacc.jnlp" 

to

"<ep_root>\staging\custom\installation\JavaClient\jacc_de.jnlp".

4. Open "<ep_root>\staging\custom\installation\JavaClient\jacc_de.jnlp" and change the 
codebase like this:

<!--URL to jacc.defaults, standard is to look at the codebase -->

Note: When using the client environment variable, the variable EP_DDM_
SITE=de (for AutoVue: EP_PVM_SITE=de) has to be removed from the file 
jacc.cmd and jack.ini.

Note: When using this option, the variable EP_DDM_SITE (and/or for 
AutoVue: EP_PVM_SITE) has to be removed from the jacc.defaults file.
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<argument>-defaults</argument><argument>$$codebase/jacc_de.defaults.</argument>
5. If not yet available, copy 

"<ep_root>\staging\product\installation\JavaClient\jacc.defaults"

to

"<ep_root>\staging\custom\installation\JavaClient\jacc_us.defaults".

6. Open "<ep_root>\staging\custom\installation\JavaClient\jacc_us.defaults" and change the 
EP_DDM_SITE to EP_DDM_SITE=us (and for AutoVue: EP_PVM_SITE to EP_PVM_
SITE=us).

7. If not yet available, copy 

"<ep_root>\staging\product\installation\JavaClient\jacc.jnlp"

to 

"<ep_root>\staging\custom\installation\JavaClient\jacc_us.jnlp".

8. Open "<ep_root>\staging\custom\installation\JavaClient\jacc_us.jnlp" and change the 
codebase like this:

<!--URL to jacc.defaults, standard is to look at the codebase -->
<argument>-defaults</argument><argument>$$codebase/jacc_us.defaults.</argument>

9. Deploy the WebStart Java Client.

Verify DFM Configuration
1. To verify the current Java Client EP_DDM_SITE (for AutoVue: EP_PVM_SITE) setting, 

create a LogiView Procedure with the following line:

put (client_env ("EP_DDM_SITE"))

For Autovue:

put (client_env ("EP_PVM_SITE"))

2. Execute the LGV procedure. If the setup is correct you will see the defined site as output in 
your client message window.

Java Daemon
The Java Daemon has to start and manage EDM Server processes. In case of a client call, it has 
to start a new server process if no matching server process is already running. If a matching 
server process is already running, it has to return the server's address. When the client 
terminates, and if no other client is connected to the same EDM Server process, the Java 
Daemon has to shutdown the EDM Server process.

The Java Daemon also has to manage all running EDM Server processes, i.e. check if there is 
still a connection between an EDM Server process and one or more clients. The Java Daemon 
always has to be able to accept a new client.

Note: With this configuration, the user at site "de" can now use the central 
WebStart Java Client with the URL for the jacc_de.jnlp file and the user at 
site "us" is using the jacc_us.jnlp file.

Example: http://server:port/Jacc/jacc_de.jnlp

http://server:port/Jacc/jacc_us.jnlp
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Daemon Configuration File jade.ini
During Agile e6 installation, the Daemon configuration file jade.ini will be installed under <ep_
root>/axalant/ini.

During installation, the administrator sets the password for the Daemon Controller. If the 
password needs to be changed, it has to be changed manually in the configuration file jade.ini.

Java Daemon Plugin

To be able to use the Java Daemon Administration Tool, it has to be activated first.

Activate Java Daemon Administration Tool
1. Start Agile e6.

2. Click the button "Change the preferences of the application".

The Agile e6 - Preferences Mask is opened.

3. Select Plugins.

The Plugins window on the right hand side displays all available plugins.

4. Select the Daemon plugin.

5. In the Load column, select the checkbox for the Daemon plugin.

6. Click Apply.

7. Click OK.

After the restart, the button "Opens the Java Daemon administration tool" is displayed.

Connect to the Java Daemon
1. In Agile e6, click the button to open the Java Daemon administration tool.

The Daemon Controller window opens at the bottom of the screen.

2. In the Daemon Controller window, click Start.

3. Select Connect to daemon...

The Connect to daemon window is opened.

4. Enter your information in the fields:

? Daemon on host

Note:  The Java Daemon Administration Tool or Plug-in is an administrator 
tool only!

Note: Password has to be encrypted.

Note: The Java Daemon Administration Tool is available in English only!

Note: To make the changes operative, restart Agile e6.
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? Port number

? Daemon password

5. Click Connect.

In the Daemon Controller screen, a list of all servers is displayed.

COLUMN NAME DESCRIPTION

No. Amount of servers.

Port Port number between server and client.

PID PID of the server process started on this machine.

Application Name of the application used by the server.

Username Name of the Agile e6 user who is using the server process.

Scope Three scopes are possible:

? Private

Connection between one client and the server.

? Batch

Batch connection between client and server.

? Public

Connection between multiple users and the server.

Account Account name of the user on the client machine.

Started from IP address of the client.
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Working with the Daemon Controller
The following functionalities are available:

? Double-clicking the Daemon Controller window banner

State ? BEGIN

Begin of initialization.

? FREEPORT

Reserved a free port.

? SERVPROP

Server Properties set up.

? START

Started Start command.

? TESTCON

Established test connection.

? FURPROP

Set further properties (VIEW, LANGUAGE).

? READY

In ready state.

? BUSY

Busy (blocked by a long running call).

? CHECK

Check (getting number of connections).

? ERR_HOST

Error: Could not get the host address.

? ERR_STORE

Error: Could not store the new AxalantServer.

? ERR_PORT

Error: Could not get a free port.

? ERR_START

Error: Could not execute start command successfully.

? ERR_CON

Error: Could not create connection to server.

? ERR_FURPR

Error: Could not set further properties (VIEW, LANGUAGE).

? ERR_LOST

Error: Server lost.

? ALERT

Alert (may be lost).

Runs since Time server was started.

Last access Last time the client and the server connected to each other and exchanged data.

Shutdown [ms] Shutdown in ms if a public server is no longer in use.

COLUMN NAME DESCRIPTION
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By double-clicking the window banner, the Daemon Controller can be extended over the 
complete Agile e6 window. Or it can be reduced to the bottom of the Agile e6 window.

? Search

– General filter

The general filter allows filtering rows for the entered search term.

– Column filter

Every column in the Daemon Controller has a filter functionality. Each column filter 
lists all terms available in the respective column.

? Administration of the server

You can administer the servers from:

– Servers menu

– Context menu

– Toolbar buttons

All three options allow to:

* Refresh

Refreshes the server list.

* Information

Additional server information can be displayed for one or more selected rows.

When selecting more than one server, the information in the Server Information 
window is displayed below each other.

* Shutdown server

This option shuts down the selected server, but not the Java Daemon.

Configuring the Daemon
1. To open the Daemon Configuration, open the Daemon menu.

2. Select Configuration.

The Daemon Configuration screen is opened.

Note: The information in the Server Information window is read only!
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? The Daemon Configuration window displays the current Java Daemon configuration 
and allows modifying certain properties.

? By highlighting a property, its description is displayed in the description area.

? The search field at the top of the window offers comprehensive search functionality.

? At the top, the following display buttons are available:

– Categorized

Displays the properties in categories.

– Alphabetic

Displays the properties alphabetically.

– Show/Hide Description Area

Shows or hides the description area at the bottom of the window.

– Expand

In the Categorized view, expands the categories.

– Collapse

In the Categorized view, collapses the categories.

? Every property value that is not grayed out, can be changed.
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1. Double-click the respective value.

2. Enter new value.

3. Click OK.

Refresh Frequency Rate
The Daemon Controller allows setting a new time value for refreshing the server list. This 
value defines after which time interval the server will be refreshed.

1. Open the Options menu.

2. Select Properties.

The Set daemon controller properties screen is opened.

3. Select Server list refresh frequency (milliseconds).

4. Enter a value.

5. Click Set property.

Disabling and Enabling the Daemon
The administrator can disable the Java Daemon, so no new server can access the Daemon. 
Requests from clients to access the respective server are denied, and the user receives an error 
message.

To disable the Daemon:

1. Open the Daemon menu.

2. Select Disable.

To enable the Daemon:

1. Open the Daemon menu.

2. Select Enable.

Shutdown Daemon
1. Open the Daemon menu.

2. Select Shutdown.

The Shutdown daemon window is opened.

There are two options how to shutdown the Daemon:

Note: Modifications are only valid for the current session and are not 
stored in the Daemon configuration file jade.ini. After shutting down the 
Daemon, these changes are lost.

Note: The new value is only valid on the used client machine and will be 
stored in the local Java configuration file jacc.ini. After a restart of the client, 
the changed value is still valid.

Note: Default refresh frequency rate = 60000 milliseconds
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? Shutdown all servers

The Daemon and all EDM server processes, that are managed by the Daemon, will be 
shutdown.

? Keep all EDM servers running

Only the Daemon will be shutdown. The EDM server processes continue running.

3. Select a shutdown option.

4. Click Shutdown.

Displaying Images with the WebStart Java Client
In case you want to display your own images in the WebStart Java Client, make sure the images 
or icon file names are all written in lower case as otherwise, they won't be displayed correctly. 
The WebStart Java Client gets the images from the Web server in which the files are case 
sensitive.

Agile e6 AutoVue Integration - Memory Settings
In some cases it is necessary to increase the available memory for the Agile e6 AutoVue 
Integration. By default, 512 MB are assigned.

Local Installation (MSI)
To change the memory settings for the locally installed deployment (JVue.msi) for the Agile e6 
AutoVue Integration, perform the following:

1. Edit the file jvue.cmd in "C:\Documents and Settings\All Users\Application 
Data\Oracle\Agile EDM" and change the following line:

set VM_OPTS=-Xmx512M

WebStart
To change the memory settings for the WebStart deployment (JVue.war) for the Agile e6 
AutoVue Integration, perform the following:

1. Copy the original file jvue.jnlp from the directory: 

%EP_ROOT%\staging\product\installation\JVue 

to 

%EP_ROOT%\staging\custom\installation\JVue

2. Edit the following line in the file jvue.jnlp to change the available memory:

<j2se version="1.7" max-heap-size="512m"/>

Note: Default size is 512 MB. Because the Agile e6 AutoVue Integration 
uses a 64-bit JVM, you can provide several GB to the Agile e6 AutoVue 
Integration. 

If you request more memory than the system can provide, the Agile e6 
AutoVue Integration will not work!

Example to provide 4GB to the Agile e6 AutoVue Integration:

set VM_OPTS=-Xmx4096M
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8Office Suite - PDF Generator Installation

One main feature of the Office Suite is the PDF generation from a MS Office file. The Office 
Suite supports a PDF printer to convert Office documents into PDF files.

Installation

The zip file is contained in the officesuitepdf.zip installation package, located in the packages 
folder of the installation medium.

1. Copy the Office Suite PDF Generator installation package (officesuitepdf.zip) from the 
packages folder of the installation medium into a temporary directory.

Example:

copy y:\packages\officesuitepdf.zip c:\temp
2. Extract the installation package.

This unpacks the Agile e6.2.1.0 Office Suite PDF Generator ZIP archive into the 
axalant\bin\java subdirectory of your temporary directory.

Example:

unzip c:\temp\officesuitepdf.zip -d c:\temp
3. Extract the Agile e6.2.1.0 Office Suite PDF Generator package into the installation 

directory.

Example:

unzip c:\temp\axalant\bin\java\officesuitepdf.zip -d"c:\Program Files 
(x86)\Agile e6".
The installation package contains the following directories:

Note: Further information about how to install the Office Suite can be 
found in the Client Installation Guide on Windows for Agile e6.2.1.0.

Note: The installation package of the Office Suite PDF Service is located in 
the packages directory and named officesuitepdf.zip.

Note: Starting with Agile e6.2.1.0 the Office pdf generator is only 
supported on e6 server machine. To install the PDF generator you also  need 
to install MS Office, the Office Suite and a PDF printer on this server. 
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? PDF Service Root (C:\Program Files (x86)\Agile_e6\Office-Suite-PDF)

– axalant

-bin

- intel-ms-nt6.1 (FMS Client binaries)

- java (Java archives)

- cmd (Windows scripts directory)

- ini (Configuration files)

- pdf (PDF service files)

- scripts (UNIX scripts)

– ext

- bin

- intel-ms-nt6.1 (external binaries)

- java (external Java archives)

– tmp (Logging directory)

4. Adapt the installation.

You need to adapt the startup script to setup the 32bit Java Runtime and the installation 
path of the Office Suite PDF Service. The script is located at the …\axalant\cmd 
subdirectory of the installation.

The pdf.bat script contains the following basic configuration settings:

set JAVA_HOME=<Java8_32bit_home>
set ep_root=<ROOT DIRECTORY OF THE OFFICE SUITE PDF SERVICE>

Example:

set JAVA_HOME=C:\Program Files (x86)\Java\jre
set ep_root=C:\Program Files (x86)\Agile_e6\Office-Suite-PDF

5. Adapt the service settings.

The OfsPdf.properties file is located at the axalant/pdf subdirectory of the installation. The 
file sets the environment variables needed to start and stop the Office Suite PDF Service.

The following properties have to be adapted.

#
# ECI connection
#
host=<PLM host>
port=<PLM port>
env=<PLM env>
scope=BATCH
#
# Client modes to define widget behaviours on client side.
# the valid values are: BATCH, TEST
#
# BATCH: no widgets will be opened on client side.
# TEST: widgets will be opened on client side virtually.

Note: The other properties must not be changed.
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#
mode=BATCH
 
#
# Directories
# <ROOT DIRECTORY OF THE PDF SERVICE> e.g. C:/Program Files (x86)/Agile_
e6/Office-Suite-PDF
# <PDF WORK DIRECTORY OF THE PDF SERVICE> e.g. C:/officesuite/PDF
#
varenv.DATAVIEW_CROO=<ROOT DIRECTORY OF THE PDF SERVICE>/axalant/bin/${e6_
windows_client_ep_mach}
varenv.ep_root=<ROOT DIRECTORY OF THE PDF SERVICE>
varenv.axalant_root=<ROOT DIRECTORY OF THE PDF SERVICE>/axalant
varenv.$TMP=<PDF WORK DIRECTORY OF THE PDF SERVICE>
#
# Host names
#
varenv.CLI_HST=pdfsrv
varenv.CLI_SRV=<PLM host>
#
# machine ID
#
varenv.EP_MACH=${e6_windows_client_ep_mach}
varenv.CLI_HWS=${e6_windows_client_ep_mach}
#
# Security settings
#
Security.KeyStoreFile=file://<ROOT DIRECTORY OF THE PDF 
SERVICE>/init/wallet/private/batch/cwallet.sso
Security.KeyAlias=orakey
#
# PLM Client
#
client1=<PLM user>,<PLM password>,office.pdf.OfsPdf

Configuration
The Office Suite needs some information to access the PDF printer and to exchange the files.

Printer Setup
The PDF printer has to fulfill the following prerequisites:

? Generate PDF file without user interaction (pure batch printing).

Note: To add a wallet, refer to the Security Guide for Agile e6.2.1.0 
Chapter Wallets > Manual Creation of Wallets > Batch.

Note: The password has to be encrypted with the batchkeytool. For more 
information, refer to the Security Guide for Agile e6.2.1.0 Chapter Encryption 
> Encrypt Passwords.

Note: The PDF work directory has to be created and entered in the EDM 
Server configuration, PDF Service, and the PDF printer.
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? Configurable PDF output folder.

? Possibility to create a <PDF-Filename>.log file in the PDF output folder, after PDF file 
creation.

Post PDF Creation Script
Prerequisite for PDF printer is the <PDF-filename>.log file creation (see above) in the PDF 
output folder. This file is the "Ready" file for the batch client to trigger the PDF file check in.

If your PDF printer does not create a <PDF-filename>.log file per default, there often exists the 
possibility to execute an application after printing. This could be used to create the 
<PDF-filename>.log file. It must be possible to set the filename "<PDF-filename>.log" as a 
parameter. The following steps describe the general setup of such a mechanism.

1. Create a file "createlog.bat" in the PDF output folder which looks like this:

set FILENAME=%~n1 
set FILEPATH=%~dp0% 
echo Done > "%FILEPATH%/%FILENAME%.log"

2. Configure your PDF printer to execute the Windows cmd shell (e.g.: 
C:\WINDOWS\system32\cmd.exe) with the following parameters (e.g %f is the file name 
parameter) :

/c C:\officesuite\pdf\createlog.bat %f

Setting up the PDF Printer

To setup the PDF printer

1. Start Agile e6.

2. Open menu Manager > Office Suite > PDF Printer.

3. Select the PDF printer from the printer list.

4. When you select the PDF printer, the following Office Suite configuration parameters are 
added to the Office Suite configuration table (System > OfficeSuite > Configuration table):

? GDM_PDF_BATCH

? GDM_PDF_DIRECTORY

The value of this configuration parameter has to be the same as the value for TEMP in 
the OfsPdf.properties file. Add "\*.pdf" at the end of it.

? GDM_PRINTER

? GDM_PRINTER_DRIVER

? GDM_PRINT_PORT

Note: The PDF output folder is the exchange folder between the PDF 
printer and Agile e6.

Note: Any folder can be used, but the configuration of the PDF printer has 
to match the configuration of the Agile EDM Office Suite PDF service.
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5. The value for the Office Suite configuration parameter GDM_ARC_NOD has to be the 
same as the value for varenv.CLI_HST in the OfsPdf.properties file.

6. In the OfsPdf.properties file, the following has to be set:

? host (e.g. edmhost)

? port (e.g. 20001)

? env (e.g. edmref)

7. In the OfsPdf.properties file, the correct user has to be entered under "client1".

8. Link the PDF Generator to a lifecycle:

The PDF Generator has to be linked to the respective transition states for the STD-DOC 
lifecycle. The Office Suite provides a LogiView procedure (GdmBatch/Archiv) to add a 
job into the PDF job list. This LogiView procedure is a transition procedure for the usage 
within the lifecycle of the Office document.

The following transition settings can be used:

Thus, when an Office Suite document reaches this state, a PDF is created automatically.

Note: GDM_PRINTER, GDM_PRINT_DRIVER, GDM_PRINT_PORT 
are set automatically.

Note: This is a section of the OfsPdf.properties file:

host=<PLM host name>
port0=<PLM eci port>
env=<PLM environment name>
varenv.ep_root=<PDF service root>
varenv.axalant_root=<PDF service binary root>
varenv.EP_MACH=intel-ms-nt6.1
varenv.CLI_HWS=intel-ms-nt6.1
varenv.CLI_HST=<Client host name>
varenv.CLI_SRV=<PLM host name>
varenv.$TMP=<PDF file exchange folder>
client1=<Connect information>

Field With change management Without change management

From 220 120

State (From) Approved In Approval

To 230 230

State (To) Release Released

System X

For Change 
Management

X

Pre-Action xedbusr_tor_rr_vr xedbusr_chk_no_obj_ews & 
xedbusr_tor_rr_vr & sig_cre_sgn

Post-Action xedbusr_tor_sa_uv & xchg_prd_unt_
poa & GdmBatch/Archiv

xedbusr_tor_sa_uv & xedbusr_rst_
prd(260) & GdmBatch/Archiv
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9. Add "GdmBatch/Archiv" to the respective states in the Lifecycle mask.

10. For every file type, for which a PDF should be created, the 'Create Archive Format' 
checkbox has to be selected in the File type mask (System > Office Suite > File Types).

Configure the Agile EDM Office Suite PDF Service
The Agile EDM Office Suite PDF Service does require some information about the local 
application, e.g. the exchange file between the PDF printer and Agile e6.

The configuration file of the Agile EDM Office Suite PDF Service has corresponding settings 
within the Agile e6 Office Suite configuration (System > Office Suite > Configuration).

The configuration table describes the settings of the configuration file of the Agile EDM Office 
PDF Service and the configuration settings of the EDM Office Suite configuration.

Office Suite configuration for the PDF service:

Office Suite PDF Service
The Office Suite PDF Service must run as a console application.

To run the Office Suite PDF Service use the pdf.bat command script located in the 
…\axalant\cmd sub directory of the installation. 

Note: After updating the lifecycle states, the client needs to be restarted.

Note: The PDF generation can only be used for file types of the storage 
type Single.

Variable Value Description

GDM_ARC_NOD Hostname of the PDF Service 
machine (e.g. pdfsrv)

Host on which the PDF files are 
created (PDF batch client)

GDM_PDF_BATCH RUN Control parameter of the job 'PDF 
Generation'

GDM_PDF_
DIRECTORY

PDF exchange directory (e.g. 
C:\officsuite\PDF_
generation\*.pdf)

Working file of the PDF generator 
(including absolute path and 
generic file name)
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The script is called with 

pdf.bat –c



Office Suite PDF Service

8-8 Oracle Agile Engineering Data Management/Administration Guide for Agile 



9

File Server Administration 9-1

9File Server Administration

File Server Administration Program
This Administration tool enables the management of the File Server. The File Server can be 
installed automatically with the Agile EDM component-based installation. Three vaults are 
created automatically (PUB (public), FMS, EIF).

The File Server Administration Tool can for example be used to execute the following 
functions: 

? Stop a File Server 

? Reload File Server configuration

? Request File Server information and flush File Server Log 

? Set the log level of a File Server 

? Create a new vault on a File Server

To execute the functions, the following arguments are available. Options market with * are only 
available with your File Server account: 

Note: If you use multiple IP interfaces the environment variable EDB_
CHOST needs to be set for the interface which should be used. To ensure that 
EDB_CHOST is used, set the environment variable EDB_CHOST_FORCE.

Note: For more information on the component-based installation of the File 
Server and the standard vaults refer to the Agile EDM Server Guide. 

-n <rpc> RPC number of the File Server (Default: 804257548)

-l Shows the File Server information

-v <number> Set the log level to number

-k Sends the shutdown request to the File Server*

-c <Vault Type> Creates a new vault*

? EIF - Extended

? FMS - Standard

? PUB - Public

More information on the specific vault types can be found below in the section 
"Adding a vault" 
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Examples for using the Administration Tool: 

File Server on Windows
On Microsoft Windows, the File Server acts as a normal Windows Service Program and can be 
started via the Start button > Control Panel > Services. Events will be written to the Windows 
Event System.

All necessary arguments to run the File Server are provided in the Registry HKEY_LOCAL_
MACHINE\Software\Wow6432Node\Agile\AgilePLM_Fileservice.

-p <path> The vault path to create a new vault

-r Reloads File Server configuration from configuration file (fileserver.cfg)*

Action Prompt

Stop a File Server fms_adm -n 804257548 -k 

Request File Server 
information and flush 
File Server Log 

fms_adm -n 804257548 -l 

Create a new vault on a 
File Server 

fms_adm -n 804257548 -c EIF -p /usr/edbserv/vault1 

Note: Because the File Server uses Microsoft Windows Access Lists and 
Security Checks, it is not possible to use vaults on FAT file systems. Use the 
NTFS file system for vaults instead.  Do not use a domain user for the service 
account of the File Server. 

Key Default Description Optional

LOG_FILE %FMS_
ROOT%\log\fms.log

File Server Log No

LOG_LEVEL 5 Report Level of File 
Server Logs

No

MAX_THREADS 10 Maximum number of 
File Server requested 
processed in parallel

No

RPC_NMB 804257548 RPC number No

USER edbserv User of service account Yes

CHECK_VAULTS 1 Check of standard vault 
(0=off)

Yes

REQ_LICENSES None Requested licenses: 
FMS_DFM = DFM

Yes

CORE_LOG %FMS_
ROOT%\log\fms_
core.log

Extended log (replaced 
by EP_ERRLOG)

Yes
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File Server on UNIX
When running the File Server UNIX additional arguments are available: 

The following example sets the command to use the RPC number 777777777 with a maximum 
of 10 parallel accesses with all log messages on standard output.

fms_srv -n 777777777 -m 10 -v -l - &

EVENT_LOG_FILE off The values for 
EVENT_LOG_FILE. 

"on"  - Create a special 
log file for some FMS 
operations, called 
events. For each FMS 
operation only one line 
is written into the log 
file. The log file is 
written in the sub 
directory log of the 
FMS and is called 
event.log

"off" - no Log file is 
created 

Yes

SECURITY_LEVEL 0x00000003 (3) 0 = Do not set and 
check file access

1 = Set and file access 
explicitly, shows 
warning in log file

2 = Sets file access 
explicitly bit does not 
check them

3 = Sets and checks file 
access explicitly and 
reports error when not 
possible.

Yes

-h Shows help

-version Shows version

-c <0|1> Disable or enable vault checks on startup

-f Disable check for additional licensed functions (DFM)

-r <licences> Requested licences (available: FMS_DFM)

-t <retry> Retry to request licences (on startup)

-u <user> Use another user account

-n <number> Use another RPC number than the default (804257548)

-m <number> Max. number of parallel tasks (= user requests), default is set to 30

-l <file> Another name for the log file (default is log/fms.log)

-verbose Write all possible information to log file

-short Write only errors to log file.

Key Default Description Optional
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In the UNIX part, Berkley Services rpc must be available at all nodes.

To manage the File Server on Unix from e6.2.0.0.2 forward, run the fmssrv script using these 
arguments available.

File Server Log
Log information for the File Server is written to the file fms.log (default: %FMS_
ROOT%\log\fms.log). Error messages and warnings are written into the Event Log (Windows) 
or the syslog (UNIX).

The File Server log can be configured by setting the following properties in the File Server 
configuration file (fileserver.cfg). The file can be found in the root directory of the File Server.

Note: : Support of homogeneous networks (UNIX LAN) comprised of 
clusters or local nodes. Heterogeneous networks have been taken into account 
in the design process. 

Note: Due to some UNIX OS changes, from e6.2.0.0.2 moving forward, 
the fms_srv script can no longer be used as standalone due to undefined 
library path. As a workaround for this, the %FMS_ROOT% must be first 
exported manually to the library path before using the fms_srv.

start Starts the File Server

stop Stops the File Server

version Shows the File Server version

Table 9–1 File Server Log

Name Default Value Possible Values Description

MaxFileSize 10000 1000-100000 The maximum file size for the fms.log in 
KB

MaxBackupIndex 10 1-9999 The maximum number of backup files like 
fms.log_0001

If the maximum number of backup files is 
reached a warning will be written to the 
syslog/ Event Log.

OverwriteOldLogs yes yes or no This setting controls if the File Server 
overwrites old backup files.

If an old backup log is overwritten, a 
warning will be written to the syslog/ 
Event Log.
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Adding a vault
With the standard installation the vaults are created automatically. To set up a vault you first 
need to create the vault definition within Agile EDM and in the next step in the Administration 
tool. 

Vaults must be created by the system administrator as a physical entity in the network. To 
create the vault directories, login with File Server User and use the File Server Administration 
Tool:

fms_adm -n <rpc> -C <Vault Type> -p <path>

Once this is done, the area can be registered with the storage area management functions of 
Agile e6.

More detailed information on directory/file permissions for the vaults can be found in the Agile 
EDM Security Guide > Agile e6 Users and Permissions Detailed Access > File Server User 
Permissions

Create a vault definition within the Agile EDM system
Vaults define and reserve a protected part of a storage media on individual computers or within 
a network. Access to this areas must go through the Agile e6 file management system and is 
restricted to users with the necessary access rights. Generally speaking, storage areas can be 
defined on any storage media within a network.

Vaults in a network are defined on the operating systems level using system privileges. Vault 
management functions of Agile e6 can be found in the File Server FMS-Vault mask. It is 
reasonable to create only such vaults that physically exist in order to ensure system integrity.

1. In Agile e6, select Manager > File Management > Vaults.

2. In Insert Mode, fill in the following fields:

StopOnError no yes or no This setting controls if the File Server 
stops to work when no new log can be 
created. If set to yes, an error message is 
displayed and posted to the system log file 
as soon as no new log file can be created. 

The File Server administrator then needs 
to move the log files out of the log 
directory either by moving all backup logs 
or moving all backup logs except the 
fms.log. 

If the logs were removed, the File Server 
works again, a re-start is not necessary.

Note: Protected areas - referred to as storage areas - can be defined at any 
node of the network that provides File Server services. Such areas can only 
be accessed with SYSTEM or ROOT privileges.

Field Name Description

Vault Unique name of the vault

Table 9–1 (Cont.) File Server Log

Name Default Value Possible Values Description
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To create a vault for the Web Client, additional information needs to be entered under the 
tab Web-Address and fill in the fields: 

3. Save the entry.

Registering the vault on the File Server by using the FMS 
Administration tool (fms_adm)
1. After the installation of the File Server the fileserver.cfg configuration file must be adapted 

to match the vault definition within Agile e6.

The fileserver.cfg defines the “valid” vault paths for the File Server.

Type IN:Check-in, vault for standard file management operations 

BCK: Backup area, vault used for the file backup

EXT: External storage area, vault that is used for export operations

Or additional storage areas if required (additional areas are treated like "IN" 
type storage areas).

Kind FMS: Standard vault, encrypted machine-dependent vault (with predefined 
names)

PUB: Public storage area, public vault with direct read access for all users via 
mounts or client programs

EIF: Extended storage area, encrypted machine-dependent vault (with cache 
directories); meta files are created for each file. 

Or additional storage areas of other File Servers are used.

Site Defines the physical location of the computer. 

Node Name of the computer/disc node of the corresponding vault.

Disc + path Defines the physical location of the computer.

Name of the computer/disc node of the corresponding vault.

Name of disc and path of the vault. Entry always has to end with a "/".

Network reference Automatically generated entry. Network reference for the File Server. 

FMS Daemon Host Name of the FMS daemon host.

FMS Daemon Port Name of the FMS daemon port.

Name Automatic system entry: User name of the user who created the vault. 

Date Automatic system entry: Date of creation.

Remark User comments.

Field Title Description

Protocol Protocol for the Web 
File Service (e.g. http)

Host Host name where the 
Web File Service runs

Port Port number of the Web 
File Service 

Path Servlet Path on the Web 
Server (Default: 
/FileService)

Field Name Description



File Server Administration Program

File Server Administration 9-7

In the default configuration file the standard vaults created by the File Server during 
startup are pre-configured and you need to add your vault path: 

[Vaults]
FMS=fms/
EIF=area/
PUB=pub/
For example you have two additional vaults in your Agile e6 vault definition:

Then the fileserver.cfg should contain the following entries:

[Vaults]
FMS=fms/
EIF=area/
PUB=pub/
CADFiles=/app/fms/vaults/cad/
OfficeFiles=/app/fms/vaults/office/

2. Reload the configuration using the FMS Administration Tool.

e.g. fms_adm -h fmsHost -n 804257548 -r

File Server Functionality in the EDM System
Several administration functions for Manager/System Users are available in the Agile EDM 
system itself. 

? Export files not needed regularly and move to an external vault

? Import files - re-import files which were previously exported to an external vault if they 
need to be changed or viewed by the user.

? Move a file to a Backup vault

? Restoring files from a Backup vault

The import, export, or transfer of files must be performed by a system administrator. Users may 
only request that files are imported / exported (flag ID) using the file management functions. 

The import, export, and transfer of files as well as backup, retrieve, copy, and distribute 
functions for files are only available between vaults of the same storage type, i.e. FMS -> FMS, 
PUB -> PUB, EIF -> EIF. 

Export files

Vault Name Host Name Path 

CADFiles fms.example.com /app/fms/vaults/cad/...

OfficeFiles fms.example.com /app/fms/vaults/offiice/...

Note: In the configuration file fileserver.cfg the size for transfer packages 
can be configured independently for every client. Also the default package 
size can be configured. 

Note: Files cannot be exported unless an export request has been generated 
for the file (Status A).
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1. Select Manager > File Management > Files.

2. Select the file to be exported.

3. Select Export file from the context menu.

4. Select a vault of the type EXT.

The original file will be deleted after the export. The external vault may later be archived 
on storage media using operating system functions. 

Import Files
Exported files must be re-imported before they can be viewed or modified. After an import 
request has been generated, the file can be imported into the system (Status E). The file to be 
imported must exist in the export area and needs to be copied from a secondary storage media 
to the corresponding export area.

1. Select Manager > File Management > Files.

2. Select the requested file to be imported. 

3. Select Import from the context menu.

Transfer File
This function transfers the selected files from a specified vault to another vault. The file must 
exist at the specified location in the source area (BCK and EXT type vaults are an exception). 
The file is deleted in the source area once the transfer is completed.

1. Select Manager > File Management > Files.

2. Select the file to be transferred.

3. Select Transfer from the context menu.

4. Select a vault.

The files stored in a vault of the type "BCK" (backup) or "EXT" (external), need not to be 
present at the specified location since the File Server cannot access secondary media. Only 
the relationships will be updated. 

The storage area type (FMS, PUB, EIF, ...) of the source and target areas should be 
identical. 

Move a File to a Backup Vault
This function transfers files from a specified vault to a backup vault. A system administrator 
may later archive the contents of the back vault using operating system functions.

1. Select Manager > File Management > Files.

Note: "Files can only be exported to vaults of the vault type "EXT". 

The vault type ("FMS", "PUB", "EIF", etc.) of the source area and the 
external area must be identical. 

Agile e6 cannot write directly to a secondary storage media It can only access 
devices that feature a file system (such as CD-ROM drives). 

Note: Files must be imported from devices with a file system (e.g. 
CD-ROM drives).
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2. Select the file to be moved to the backup area.

3. Select Backup from the context menu.

4. Select a vault.

Backup files must be transferred to backup vaults (vault type must be "BCK"). 

The vault type ("FMS", "PUB", "EIF", etc.) of the source area and the target area must be 
identical. 

Exported files (vault type "EXT") and files in a backup vault (vault type "BCK") cannot be 
archived with this function. 

Files can only be stored once in a vault. Consecutive backup operations of a file to a vault 
will overwrite the original backup file.

Restore a File
This function restores a file from a specified (backup) vault at its original location in the vault. 
The file to be restored in the system must exist at the specified location of the backup area. The 
system administrator needs to copy files to be restored in the system from a secondary storage 
media to the corresponding backup area.

1. Select Manager > File Management > Files.

2. Select the file to be restored into the system.

3. Select Store back from the context menu.

4. Select a vault.

Files can only be restored from a vault (storage area) of vault type "BCK". 

The vault types ("FMS", "PUB", "EIF", etc.) of the backup vault and the original (target) vault 
must be identical. 

Exported files (vault types "EXT") cannot be restored in the system. Distributed copies of files 
that have been distributed to several vaults will be marked as "not actual" (relationship status 
"N"). Only the original file will retain the "actual" status (relationship status "A"). 

In case of an original file the "Change date" and "File size" fields will be updated once the 
restore process is complete.

Distribute Files into a different Vault
Sometimes files need to be distributed into several vaults. Distribution into several vaults can 
ensure that users, who do not have access to certain areas, will have access to certain files or 
you may wish to distribute into additional backup vaults.

Note: Files must be imported from devices with a file system (e.g. 
CD-ROM drives).

Note: Files must be imported from devices with a file system (e.g. 
CD-ROM drives).
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Web-enabled File Server
If you are operating a data service or a file service you will need to install the servlets into your 
Tomcat servlet container. If a site is just implementing one of the two it can switch off not 
needed servlets by adapting the web.xml configuration file. If you operate a file service the 
servlets will need access to the usual native fms libraries.

Normally the presentation service will be tightly coupled with the data service. But if you have 
access to existing services on your network you could just access these services in your 
presentation service and would not need to install the servlets. Still the access to the data 
service must be protected with authentication and authorization mechanisms as mentioned 
above.

The users do not need to install DLLs or other components on top of the browser.

If you use a web presentation service (Web Client), the Web File Service requires access to this! 
Using a Java Client the access is not required.

The web based file management assumes three factors:

? A (meta) data service in cooperation with a presentation service to manage data about 
documents and files and display it to the user.

? Access to these services must be protected with authentication and authorization 
mechanisms.

? A file service that manages the physical files. A user or application who wants to check-in, 
check-out or delete files via the browser.

These factors may be based on different machines connected through LAN or WAN or just on 
one machine (mainly during test). In most cases all services will run on one machine while the 
users browser will run on a different machine. For better security the communication between 
the user and the services should use SSL connections. The communication between the services 
is based on encrypted messages.

Technical View of the WebFile Server

Secure Socket Layer (SSL)
Web servers support the HTTPS protocol which encrypts the data to inform the caller about the 
server the data is coming from. 

For more information about setting up the HTTPS environment refer to the Apache Tomcat 
Security information on the following Apache Web page: 
http://tomcat.apache.org/tomcat-8.0-doc/security-howto.html

Communication Path during File Viewing
This section describes the communication between the several components in a medium and 
high-end security environment.
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Software components:

Communication steps:

1. The user pushes the viewing button to view a file.

2. The Web Client calls the xfile userexit over ECI.

3. The PLM Server calls the FMS callable over ECI (the Meta data will be stored in the 
Cache of the FMS Data Service).

4. The Web Client responds a redirection URL to the browser and the browser sends a GET 
request to the Web File Service (the request contains an access ticket).

5. The Web File Service decrypts the access ticket and sends a signed request envelope to the 
FMS Data Service to gain the Meta data.

6. The FMS Data Service responds with a signed envelope, which contains the Meta data.

7. The Web File Service calls the File Server via RPC by using the FMS client library. The 
RPC return packet contains the socket for the file transfer.

8. The File Server creates a new thread for the file transfer and sends the file via socket to the 
calling Web File Service.

9. The Web File Service sends the receiving data without caching as respond of the 
redirection GET request to the browser.

The high-end security environment communication is a little bit different.

Browser The browser is used to access the web site on the Web Server.

Web Client The Web Client is a web service, which gains access to the Agile EDM system.

FMS Data Service The FMS Data Service is an internal service, which provides the Meta data for 
the file access.

Web File Service The Web File Service provides the file access for the user.

PLM Server The PLM Server represents the Agile EDM system.

File Server The File Server manages the files within the Agile EDM system.
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Software components:

Communication steps:

1. The user pushes the viewing button to view a file.

2. The Web Client calls the xfile userexit over ECI (the PLM Server checks if a proxy 
configuration is available for the Web Client site and adds the proxy data to the Meta data).

3. The PLM Server calls the FMS callable over ECI (the Meta data will be stored in the 
Cache of the FMS Data Service).

4. The Web Client responds a redirection URL to the browser and the browser sends a GET 
request to the Web File Service (the request contains an access ticket).

5. The Web File Service decrypts the access ticket and sends a signed request envelope to the 
FMS Data Service to gain the Meta data.

6. The FMS Data Service responds with a signed envelope, which contains the Meta data.

7. The Web File Service generates a POST request to the Web File Service, which is running 
on the internal Web Server to get the file. The POST request contains an encrypted 
envelope with the Meta data.

8. The Web File Service calls the File Server via RPC by using the FMS client library. The 
RPC return packet contains the socket for the file transfer.

9. The File Server creates a new thread for the file transfer and sends the file via socket to the 
calling Web File Service.

Browser The browser is used to access the web site on the Web Server.

Web Client The Web Client is a web service, which gains access to the Agile EDM system.

FMS Data Service The FMS Data Service is an internal service, which provides the Meta data for 
the file access.

Web File Service The Web File Service provides the file access for the user.

PLM Server The PLM Server represents the Agile EDM system.

File Server The File Server manages the files within the Agile EDM system.
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10. The Web File Service sends the incoming file data without caching to the calling proxy 
Web File Service.

11. The (Proxy) Web File Service send the receiving data without caching as respond f the 
redirection GET request to the browser.

Configuration

The possibilities to configure the Web Proxy Server of the web file management system is 
described here.

The web proxy supports a main switch to activate or deactivate the proxy mechanism. The 
main switch is accessible via the "Configuration parameter" mask (Manager > System 
Configuration > Other Parameters).

EDB-FMS-PROXY -> ON/OFF (default)
You have to insert this configuration parameter to activate the proxy mechanism.

In case of a high-end security environment, the Web File Service on the external Web Server 
works as a proxy to the internal Web File Service. The definition of a Web Proxy needs two 
steps.

1. Define a default proxy for a site or a specialized proxy for a vault for the site.

You can define a set of default proxy entries for several sites, by adding the information of 
the external Web Server with the path to the (Proxy) Web File Service.

Additionally, you can define a set of proxy entries for several sites, by adding the 
information of the external Web Server with the path to the (Proxy) Web File Service. If a 
vault has no proxy information, the default proxy information is used.

2. Set the site information in the configuration file of the Web Client.

Each external Web Client should have a unique site information, so that the PLM Server 
could decide if a (Proxy) Web File Service is necessary. You can add this information in 
the webplm.properties file of the Web Client, which is located in the <webclient_
root>/config directory.

The following line sets the site "www" for this Web Client:

axalant.env.EP_PROXY_SITE=www

Note: The JNI of the 64bit JVM does not work with 32bit libraries and the 
File Server client library cannot be loaded.The 32bit JVM is the only 
supported JVM on AIX.

Field Name Description

Site Site of Web Client 

Protocol Protocol for the Web FileService (e.g. http) 

Web Host Host name where the Web File Service runs 

Web Port Port number of the Web FileService  

Web Path Servlet Path on the Web Server (Default: /FileService) 
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Administration

The Config file web.xml

The web file service has a configuration file to setup the necessary data for the servlets.

The General Section

Servlet definitions
Data Service

A Servlet to handle the data information about file operations. It has a dual role. One role is as a 
singleton that can be accessed from other classes of the application. The other role is of a 
servlet that can be POSTed to.

Check-in Service

Accepts a file posted as multi-part form data and checks it into the file management system. A 
free (for some requirements see the license) MultipartParser is available from Jason Hunter 
(www.servlet.com) and his cos.jar is used by FmsCheckinServlet.

Checkout Service

Handles checkouts from the file management system. File check-outs can be requested from 
this servlet. A handle must be supplied that has been issued from the application. 
FmsCheckoutServlet will then initiate a communication with the FmsDataServlet to finish the 
operation.

Delete Service

Handles delete requests from the file management system File deletes can be requested from 
this servlet. A handle must be supplied that has been issued from a data source. 
FmsDeleteServlet will then initiate a communication with the data source to finish the 
operation.

Additional MIME Types

The following content types are currently mapped to the associated file extensions in the 
Tomcat web.xml file.

Further content types can be added in the web.xml file!

Key Default Description

Webmaster myaddress@mycompan
y.com

The e-mail address of the administrator to whom 
questions and comments regarding this application 
should be addressed to.

tracemasks Default all 0 Trace masks and flags for packages and classes: 0 - 
no output 1 - trace output 2 - debug output 3 - trace 
and debug output

Key Default Description

ECIHandleLifeTime 3600 lifetime in seconds before an ECIHandle expires 
5min=300 1hr=3600 1day=86400

Key Default Description

maxPostSize 100242880 The maximum size in bytes a posted file may have.
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Several DIFFERENT content types use the same extensions:

Mime Content-Type File Extensions Comment

application/msword .doc Microsoft Word Documents

application/octet-stream .exe, .bin Binary

application/pdf .pdf Adobe Portable Document Format

application/postscript .ps Adobe Postscript

application/rtf .rtf Microsoft Rich Text Format Docs

application/vnd.framem
aker

.fm, .frm, .frame Adobe Frame Maker

application/vnd.hp-HP
GL

.pgl HP Graphics Language files

application/vnd.lotus-1-
2-3

.wks,.wk3,.wk4,.wg2,.
wt4,.123

Lotus 123 Files

application/vnd.lotus-fr
eelance

.pre,.prz,.mas,.prs Lotus Freelance Files

application/vnd.lotus-w
ordpro

.lwp Lotus Wordpro Files

application/vnd.ms-acc
ess

.mdb Microsoft Access Files

application/vnd.ms-exc
el

.xls,.xlc Microsoft Excel Files

application/vnd.ms-po
werpoint

.ppt,.pot,.pps Microsoft Powerpoint Files

application/vnd.ms-proj
ect

.ppm Microsoft Project Files

application/vnd.visio .vsd,.vst,.vsw,.vss Visio Drawing File

application/x-mif .mif Maker Interchange Format (Frame)

application/x-msbinder .obd Microsoft Binder Files

application/x-quattro-w
in

.wb1,.wb2,.wb3 Quattro Pro for Windows Files

image/cgm .cgm Computer Graphic Metafile (CGM)

image/g3fax .fax Fax

image/gif .gif GIF image files

image/jpeg .jpg,.jpeg,.jpe JPEG image files

image/png .png Portable Network Graphics Files

image/tiff .tif,.tiff TIFF Image Files (.TIF)

image/vnd.dwg .dwg AutoCad files

image/vnd.dxf .dxf AutoCad Interchange Files (.DXF)

image/vnd.fpx .iges, .igs Kodak Flash Pix

model/vnd.dwf .dwf AutoCad drawing files

text/x-vcard .vcf VCard
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Mime Content-Type File Extensions Comment

application/wordperfect
5

.wpd WordPerfect 5 documents

application/wordperfect
5.1

.wpd WordPerfect 5.1 documents

application/x-wordperfe
ct6

.wpd WordPerfect 6 documents
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10Printing Configuration

Lightweight Reporting

Userexit pri_wdg

Note: For further information regarding Lightweight Reporting please refer 
to the Online Help > Getting Started documentation.

Note: For further information regarding the userexit pri_wdg please refer to 
the Online Help > DataView documentation.
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11Setting Up the Online Help

To make the Online Help available in the Java and Web Client, complete the following steps:

1. In your Agile e6 installation folder, create the directory structure 
".\axalant\htd\htdocs\axalant\doc_ep\eng".

2. Download the Online Help for Java and Web Client from the Oracle Technology Network 
website:

http://www.oracle.com/technetwork/documentation/agile-eseries-098047.ht
ml

1. For Agile e6.2.1.0, click on the link HTML.

2. Download the documentation package Online Help for Agile e6.2.1.0 (Java/Web 
Client).

3. Save the zip file into the directory ".\axalant\htd\htdocs\axalant\doc_ep\eng".

3. Extract the zip file into the …\eng directory.

On UNIX use unzip, and on Windows use Winzip or 7zip to extract the file.

4. Copy the "axalant" folder, which is located under the htdocs folder, to a Web Server of 
your choice. Copy the axalant folder directly below your document root of your Web 
Server.

Example:

1. Use the HTTP server of your Admin Server installation (Apache Tomcat) located 
under:

Note: The following configuration parameters are not supported by 
standard help, but could still be used for customer specific help:

- EDB-HLP-MASK

- EDB-HLP-MASK-MSH

- EDB-HLP-PATH

- EDB-HLP-PATH-EDBKERNEL

Note: The zip file is only available in English. If the dump language is set 
to German, create a directory structure ..\doc_ep\ger and extract the zip file in 
the "ger" directory. If the dump language is set to French, create a directory 
structure ..\doc_ep\fr and extract the zip file in the "fr" directory.
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Windows:

%ALLUSERSPROFILE%\agile\installer\6.2.1\admin

UNIX:

$HOME/.agile/installer/6.2.1/admin.

2. Navigate to the directory "webapps".

3. Create a new directory "help".

4. Copy the "axalant" folder, which is located under the htdocs folder, to the "help" 
folder.

5. Log in to Agile e6 as a manager user (e.g. edbcusto, demoep_m).

6. Select System > Other Parameters.

7. In the configuration mask, search for rubric EDB-HLP and select the folder Configuration 
parameter.

8. Set the documentation root EDB-HLP-ROOT to:

http://<http server name>:<http port>/help/axalant/

The program adds /doc_ep/eng/ or /doc_ep/ger/, depending on which language is active, 
followed by the index file name index.html.

? English:

http://<http server name>:<admin http port>/help/axalant/doc_
ep/eng/index.html

? German:

http://<http server name>:<admin http port>/help/axalant/doc_
ep/ger/index.html

On UNIX Systems, Agile e6.2.1.0 starts Mozilla as a default. If the browser is not defined, 
follow the steps below:

1. Select Manager > External Applications to specify different browsers on different 
operating systems and client nodes.

This is where the default browsers for each available UNIX System are defined. For 
Microsoft Windows the default system HTML browser is used.

2. Copy the line for your hardware architecture and insert the hostname and browser name.

? File type is equal to HTML

? Mode is equal to H (help)

? "-" is a wildcard and means every possible value (like *)

Using WebLogic Server
The WebLogic Server can be used to provide the Online Help. In WebLogic you can develop a 
simple Web application to display static HTML content.

1. Download the Online Help for Java and Web Client from the Oracle Technology Network 
website:

Note: Make sure that all of the following are true:
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http://www.oracle.com/technetwork/documentation/agile-eseries-098047.ht
ml

a. For Agile e6.2.1.0, click on the link HTML.

b. Download the documentation package Online Help for Agile e6.2.1.0 (Java/Web 
Client)

2. Save the zip file into a new directory, e.g. online_help.

3. Extract the zip file in this directory.

On UNIX use unzip, and on Windows use Winzip or 7zip to extract the file.

4. Login to the WebLogic Console and deploy the online_help directory as an application.

5. Click Deployments.

6. Click Lock & Edit.

7. Click Install and set the path to the directory created in step 2.

8. Click Next.

9. Select a Managed Server to deploy to and click Next.

10. Accept the defaults and click Finish.

The deployment completes successfully.

11. Click Activate Changes.



Using WebLogic Server

11-4 Oracle Agile Engineering Data Management/Administration Guide for Agile 



12

DFM Web Service Configuration 12-1

12 DFM Web Service Configuration

DFM is supported with the Web Service interface. The DFM Web Service configuration is 
performed in the database, thus the web deployment of the DFM Web Service is simplified. 
The configuration has to be performed before starting the Document Management Web Service.

In Agile e6 on the FMS-Vault mask, configuration information for the FMS Java Daemon can 
be added:

? FMS Daemon Host

? FMS Daemon Port.

The DFM Web Service configuration for the different DFM sites, including the main Web 
Logic server(s), are managed by using site specific configuration parameter.

? EDB-WSI

EDB-WSI is the main rubric for the DFM Web Service configuration, and it contains the 
default Web Service URLs for the Web Logic server and the default DFM sites.

– EDB-WSI-URL

URL of the CoreServices deployed in the application domain of the Web Logic Server.

If necessary, the configuration parameter EDB-WSI-URL can be adapted site specific. 
It usually points to the central Web Logic installation for all DFM locations.

– EDB-WSI-DFM-URL

URL of the StreamingFileService which is deployed in the installation domain of the 
Web Logic Server.

The configuration parameter EDB-WSI-DFM-URL can be adapted site specific for the 
different DFM location.

Note: Please be aware that these configuration parameter need to be created 
by an Administrator first.
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13Appendix

Environment Configuration Parameters
Each EDM Server process has an environment, which is set on startup. An Agile e6 application 
consists of environment variables which are set through shell scripts and additional 
configuration values read by the EDM Server process at startup from XML configuration files. 
Information about EDM Server environment variables can be found in the Agile e6 Online 
Help.

Startup Process on Windows
? Invoking EDM Server startup through Java Daemon

? %ep_root%\axalant\cmd\axalant_srv.cmd

– %ep_root%\axalant\cmd\plm_env.cmd

Read for all applications.

– %ep_root%\axalant\cmd\plm_env_dev.cmd

If exists, read for all applications, not available in standard installation.

– %ep_root%\axalant\cmd\plm_env_cust.cmd

If exists, read for all applications, not available in standard installation, customers 
should add their modifications for all applications here.

– %ep_root%\init\%env_name%.cmd

Read for specified application only.

– %ep_root%\init\%env_name%_cust.cmd

If exists, not available in standard installation, read for specified application only, 
customers should add their modifications for all applications here.

Startup of EDM Server process which reads:

? %ep_root%\init\axalant.xml

Read for all applications which are defined in "%ep_root%\init\%env_name%.xml", which 
is the default.

Note: The next two sections describe the internal Agile e6 startup of an 
EDM Server process.
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? %ep_root%\init\%env_name%.xml

Startup Process on UNIX
? Invoking EDM Server startup thru Java Daemon

? ${ep_root}\axalant\scripts\axalant_srv

– ${ep_root}\axalant\scripts\plm_env.sh

Read for all applications.

– ${ep_root}\axalant\scripts\plm_env_dev.sh

If exists, read for all applications, not available in standard installation.

– ${ep_root}\axalant\scripts\plm_env_cust.sh

If exists, read for all applications, not available in standard installation, customers 
should add their modifications for all applications here.

– ${ep_root}\init\${env_name}.sh

Read for specified application only.

– ${ep_root}\init\${env_name}_cust.sh

If exists, not available in standard installation, read for specified application only, 
customers should add their modifications for all applications here.

Startup of EDM server process which reads

? ${ep_root}\init\axalant.xml

Read for all applications which have defined it in "${ep_root}\init\${env_name}.xml", 
which is the default.

? ${ep_root}\init\${env_name}.xml

Startup Shell Scripts
This section describes the environment variables which can be modified by the customer.

? If the environment variable should be set for all applications, use "plm_env_
cust.<extension>".

? If the environment variable is application specific then use "%env_name%_
cust.<extension>".

? If the files do not exist, they must be created.

Environment 
Variable Description Values Optional Example

axalant_tmp Path to the EDM 
Server log files.

$ep_root/tmp no $ep_root/tmp or %ep_
root\tmp

axalant_data Path to the EDM 
root

$ep_root Not used in 
code! 
Maybe 
obsolete

$ep_root or %ep_root

ORACLE_HOME Path to the Oracle 
client home 
directory.

- no D:\oracle\product\12.2\db_
1
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NLS_LANG National language 
set for the Oracle 
client to use for the 
EDM Server 
process.

- no AMERICAN_
AMERICA.AL32UTF8

TNS_ADMIN Path to the 
tnsnames.ora for the 
Oracle client to use 
for the EDM Server 
process.

- no %ORACLE_
HOME%/network/admin

EP_DEBUG A comma separated 
list containing the 
modules that should 
generate debug 
output. Special 
entries are _all_ to 
debug all modules, 
Main for the main 
routine and 0 to turn 
off debug output.

If debug output is 
enabled, each Agile 
e6 process creates 
an 
axalant-<hostname
>-<pid>.err and .out 
file to capture stderr 
and stdout.

Be aware that using 
the value _all_ will 
have a negative 
performance impact 
on the EDM Server, 
and it will generate 
huge log files.

_all_, 0, or a 
comma 
separated list of 
module IDs (as 
defined in 
axalant.xml or 
ebd_mid.h).

Yes Main,Mod,Epq,Lgv

EDB_LOGDIR Directory for the 
log files created by 
the EP_DEBUG 
setting. Default is 
${ep_root}/tmp.

Directory with 
path

Yes /my/log/dir

EDB_
LOGSIZEBUFFER

Buffer size in bytes 
for stderr output. If 
0 is specified, the 
output will be 
unbuffered.

A value of 0 should 
only be used if 
crashes occur and 
the log buffer is not 
flushed to disk. 
Maximum size used 
is currently 1024. 
Values greater than 
1024 are ignored.

0 to 1024 Yes 1024

EDB_TRC_ALL Deprecated. Use 
EP_DEBUG with 
Epq instead.

Environment 
Variable Description Values Optional Example
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Startup Configuration Files
In Agile e6, the application configuration files are in XML format and can be found in the <ep_
root>/init directory (e.g. <application>.xml and axalant.xml). They replace the former *.edb 
files in the same directory. Some basic attributes in the application specific <application>.xml 
file can be modified over the Administration client web interface. If you need to change the 
enhanced attributes, the files can be edited manually with an editor.

All changes not performed over the Administration client web interface will be lost if you use 
the Administration client web interface again to change the values of the application.

<application>.xml
The following section describes the attributes of the XML nodes that can be defined in the 
XML file.

In a standard installation not all attributes are defined in the XML file and default values are 
used.

General Node
<General SignalFlag="1" ModuleConfig="axalant.xml" TraceConfig="" 
UseCommonTraceFile="1"/>
DbBlobLocation="edb_lob"

EDB_TRC_DEBUG Deprecated. Use 
EP_DEBUG with 
Epq instead.

PATH PATH to use for the 
EDM Server 
process.

- no PATH=%ORACLE_
HOME%/bin;%PATH%

Attribute Description Values Optional Example

SignalFlag If the entry is 1, Agile 
e6 catches runtime 
errors and stops the 
server process in a 
controlled manner.

For instance, all 
database connections 
are disconnected. 
This might cause 
hanging server 
processes and is 
therefore deactivated 
by default.

0 or 1 Yes 1

Environment 
Variable Description Values Optional Example
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Database Node
<Database Library="epq10c_ora112" Vendor="Oracle" Version="112" 
User="plmref@plm61" Pwd="plmref"
      ParallelConnect="ON_DEMAND_CONNECT"
      ParallelConnectTimeout="10"
      DbWuqSP="Static"
      BindMode="All"
      Wildcards="?%"
      Querymode="MIXED">
   </Database>
 

ModuleConfig Contains the name of 
the configuration 
source which is used 
as the primary source 
for the Agile e6 
module definitions.

All modules of this 
source are registered. 
From the original 
configuration source, 
only the modules 
entered in 
[Modules\Custom] 
will be registered.

The module IDs must 
be unique over all 
sources.

File name of the primary 
module source:

[X:][path]filename.xml

[F:][path]filename.edb

If specified without type 
F or X, the same type as 
the original source is 
assumed. If specified 
without path, 
${ep-root}/init is used.

Yes axalant.xml

TraceConfig The Path to the C++ 
trace configuration 
file.

F:<path to trace config 
file>

Yes F:D:\oracle\pl
m61\axalant\i
ni\trace.edb

UseCommonTraceFile If the entry is 1, the 
EDM Server writes 
all common traces 
(SQL, C/C++ and 
LogiView) into the 
standard server trace.

0 or 1 Yes 1

Attribute Description Values Optional Example

User The schema name and the 
SQLnet connect string of 
the database to which the 
application should 
connect to.

e.g. plmref@plm61 n -

Pwd The password of the 
database schema to which 
the application should 
connect to. Can be 
encrypted, but also clear 
text passwords are 
possible.

e.g.: plmref or encrypted 
e.g: 
{PLM-AES-128}JoMHO
s.....NpMCDcytN+DJI

n -

DbBlobLocation Table space for the 
database Blob fields

edb_lob

Attribute Description Values Optional Example
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ParallelConnect This setting manages the 
Oracle database 
connection behavior when 
a data record is going to 
be updated with the 
function "epqupdpar()". 
The major use case for 
this functionality is the 
number server so that 
pulling a new number 
from a number cycle is 
done in a parallel 
connection. The 
concurrency of the 
requested data 
modification is vastly 
improved by enabling a 
parallel connection.

Important: This setting 
does not influence the 
standard behavior of any 
database transaction, it is 
only important for a very 
small number of functions 
explicitly using 
"epqupdpar()" instead of 
"epqupd()"

NO_PARALLEL_
CONNECT - Update of 
the data record via 
"epqupdpar()" will be 
executed within the 
current transaction. The 
concurrency of an 
application transaction is 
low and this setting 
should be used only for 
small installation size 
and/or small number of 
statements in a 
transaction.

PERMANENT_
CONNECT - A 
permanent parallel 
database connection will 
be opened when an update 
of a data record via 
"epqupdpar()" is 
requested. This 
connection will require 
additional memory 
resources in favor of a fast 
response time for an 
update. The concurrency 
of an application 
transaction is high.

ON_DEMAND_
CONNECT - A temporary 
parallel database 
connection will be opened 
when an update of a data 
record via "epqupdpar()" 
is requested. This 
connection will require 
temporarily additional 
memory resources and 
will also take more time 
for execution due to the 
time required to open and 
close a parallel 
connection. Closing the 
parallel connection is 
influenced by the 
"ParallelConnectTimeout"
. The concurrency of an 
application transaction is 
high. This setting is the 
best one if the memory 
resources are very limited.

Y, Default 
in EPQ: 
'NO_
PARALL
EL_
CONNEC
T' Default 
in 
Installatio
n: 'ON_
DEMAN
D_
CONNEC
T'

-

Attribute Description Values Optional Example
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ParallelConnectTi
meout

Determines when the 
parallel connection in 
mode "ON_DEMAND_
CONNECT" will be 
closed after 
<ParallelConnectTimeout
> seconds due to 
inactivity. After each 
read-only statement, a 
check occurs when an 
update in the last parallel 
connection has happened, 
and if the timeout has 
been exceeded, the 
parallel connection is 
closed.

Value in seconds e.g. 10 
for 10 seconds inactivity

A value of 0 immediately 
closes the parallel 
connections after it has 
been used.

Y,

Default in 
EPQ: 0

Default in 
Installatio
n: 10

-

DbWuqSP Defines which algorithm 
will be used for a "Where 
Used Query" or "Structure 
Explosion". There is a 
"dynamic" version 
available which created a 
temporarily stored 
procedure during runtime, 
which is suited to the 
requested query for a 
specific table. The other 
version uses a stored 
procedure which is static 
and part of the standard 
database dump.

Note: This is an internal 
parameter, please change 
it only after being advised 
by a support engineer.

Static - Static stored 
procedure in database 
dump

Dynamic - Stored 
procedure which will be 
created during runtime

Y, Default 
is: 'Static'

BindMode Manages the usage of 
place holders in the 
dynamic SQL statements. 
Using place holders is 
important to avoid the 
need to parse SQL 
statements if many SQL 
statements have the same 
structure but different 
values for variables. Not 
using place holders will 
add the parsing time on 
database server side to the 
execution time for each 
SQL statement.

Note: This is an internal 
parameter, please change 
it only after being advised 
by a support engineer.

Value is an integer 
handled as a bit mask; 
each value is specific for a 
condition value in a 
WHERE-clause. The 
value in a clause is the 
SQL keyword:

Interval (between): 1

Equal (=): 2

Like (like): 4

Less than, or greater than: 
(<,>):8

Less equal, or greater 
equal: (<=,>=): 16

Y, Default 
is 31, for 
Oracle 8 
Databases 
it has 
been only 
Equal(2)

Using place 
holders for all 
conditions:31

Using place 
holders only 
for an Interval 
and Equal 
conditions:3

Attribute Description Values Optional Example
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Wildcards Sets the characters to 
define the single and the 
multi wildcard in the 
database. A single 
wildcard is a place holder 
in a query for exactly one 
character; a multi 
wildcard is a placeholder 
for zero to many 
characters.

There are many places in 
the application to define 
wildcards, it is important 
to understand in which 
order the wildcard 
definitions are evaluated. 
Please see here the order 
of evaluation (first line is 
also first evaluated):

Configuration parameter 
(this entry here) 
Wildcards

Command line parameter: 
-w

DataView Defaults 
SYSTEM parameter: 
WILDCARD

DataView Defaults USER 
parameter: WILDCARD

To simplify the wildcard 
definition it is strongly 
recommended to use the 
WILDCARD parameter in 
the DataView defaults 
only.

Any combination of 2 
ANSI characters, special 
characters are 
recommended

Y, 
Default: 
'?%'

Setting an 
asterisk for 
multi wildcard 
like on a 
Windows or 
UNIX shell: 
'?*'

Attribute Description Values Optional Example
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Security

<Security>
  <Default KeyStoreFile="file://D:/oracle/plm61/init/wallet/private/server/"/>
  <ws_sso KeyStoreFile="file://D:/oracle/plm61/init/wallet/private/ws/"/>
  <abs_sso KeyStoreFile="file://D:/oracle/plm61/init/wallet/private/sso/"/>
</Security>

IPC Node
<IPC AbsEciUrl="eci://www.example.com:19997" SecurityLevel="process" 

Querymode Defines the mode how a 
query for data will be 
handled. Queries for exact 
matches and wildcard 
matches are distinguished. 
An exact match is 
containing no wildcard 
e.g. 'abcdef' while a 
wildcard match contains 
any combination of 
wildcards e.g. 'a?cd%f'. 
There are many places in 
the application to define 
the query mode, it is 
important to understand in 
which order the query 
mode definitions are 
evaluated. Please see here 
the order of evaluation 
(first line is also first 
evaluated):

Configuration parameter 
(this entry here) 
Querymode

Command line parameter: 
-q

DataView Defaults 
SYSTEM parameter: 
QUERYMODE

DataView Defaults USER 
parameter: 
QUERYMODE

To simplify the query 
mode definition it is 
strongly recommended to 
use the QUERYMODE 
parameter in the 
DataView defaults only.

SENSITIVE - Queries 
will distinguish upper and 
lowercase character. This 
will provide the best 
database performance.

INSENSITIVE - Queries 
will not distinguish 
between upper and lower 
case characters.

MIXED - Queries will use 
'SENSITIVE' for exact 
matches and 
'INSENSITIVE' for 
wildcard matches. This 
provides the best balance 
between performance and 
usability of a query

Y, 
Default: 

MIXED'

A query for 
'abc' match in

SENSITIVE: 
only 'abc'

INSENSITIVE
: 'abc', 'Abc', 
'ABC', 'aBc', ...

MIXED: for 
exact matches 
only 'abc', for 
wildcard 
matches 'abc', 
'Abc', 'ABC', 
'aBc', ...

Attribute Description Values Optional Example

KeyStoreFile The location of the 
Oracle Wallet file used 
by the EDM Server.

file://%ep_
root%/init/wa
llet/private/<
wallet-type>/

no file://%ep_
root%/init/wallet/private/server/

Attribute Description Values Optional Example
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TicketLifeTime="600"        
       Node = "www.example.com">
   </IPC>

Attribute Description Values Optional Example

AbsEciUrl The URL where the 
business service can be 
reached on the Oracle 
WebLogic Server.

The port must match the 
"Port" entry in the ABS_
<env>.ini file on the Oracle 
WebLogic Server.

eci://www.example.com:19
997

- -

Protocol Also configurable in the 
command line.

If the configuration file or 
command line contains both 
entries and if the command 
line also contains the 
resource to be used, Agile 
e6 is started in ECI Server 
mode and can be contacted 
by ECI clients via the 
specified parameters (see 
ECI Manual).

<ECI Protocol ID> Yes 1

Node The host name of the EDM 
Server when running as an 
ECI server.

Fully qualified host name Yes www.exam
ple.com

SecurityLevel This entry specifies the 
security level to be used for 
IPC connections.

The default value of 
connection should be used 
whenever possible, to 
ensure that no unauthorized 
access is possible.

Use the other values only if 
a legacy integration is not 
capable of passing 
credentials during an ECI 
connect.

An Agile e6 application 
using a value other than 
connection should be 
secured by firewalls, so that 
only the legacy system has 
remote access to the Agile 
e6 server.

One of:

unrestricted: no 
authorization required to 
establish the connection.

process: first IPC 
connection needs to 
authorize by passing 
credentials.

connection: each IPC 
connection needs to 
authorize by passing 
credentials. [default]

Yes process

TicketLifeTime The life time value of EDM 
tickets for multiple ECI 
connections.

Expire value in seconds Yes 21600 
(default)

Note: In case of long processes, as e.g. batch processes, it is recommended 
to set the time value for the TicketLifeTime to "0", thus defining an indefinite 
timeout.
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Modules Node
<Modules>
<Core>
           <Class Name="Classification" Library="epsrv_edb" Type="embedded" 
Startup="immediately"/>
       </Core>
       <Custom>
           <Sample Name="Sample Custom module" Library="sample"/>
       </Custom>
   </Modules>

The Modules element contains two child elements called Core and Custom. Each of these child 
elements may contain any number of module definitions, where the element name is used as 
Module ID.

The attributes of each element are as follows:

LogFileMgr/CpsVerify Node
<LogFileMgr>

Attribute Description Values Optional Example

Name A short description of the 
module. This is displayed 
in the library list of Agile 
e6.

A human readable name No Sample Module

Library The name of the library to 
be loaded, if possible 
without path and 
operating-system-specific 
suffix

Library name No epsrv_sample

Entry The name of the entry 
function of the module.

This information is 
provided by the supplier 
of the respective module.

If the entry does not exist, 
it is derived from the 
module ID as follows:

<mod-id>_Entry

Function name Yes Sample_Entry

Startup Controls the automatic 
start-up of a module.

If the entry does not exist, 
the module is only loaded, 
initialized and started on 
demand.

One of

immediately: Starts the 
module immediately during 
server startup.

onDemand: Starts if a 
userexit requests the module 
[default]

disabled: Does not start the 
module.

Yes onDemand

Type Specifies the module type, 
standard is dynamic.

One of:

Static

embedded: Only used for 
internal Agile e6 modules.

dynamic: Standard value for 
external modules. [default]

Yes dynamic
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<CpsVerify Mode="append" Prefix="CpsVerify">
       </CpsVerify>
   </LogFileMgr>
 

PLMPresentationServices Node
<PLMPresentationServices Report_Service_
URL="http://www.example.com:7103/AgilePlmWps/reporter/report"/>
<Windows DATAVIEW_TBSP="edb" DATAVIEW_IXSP="edb_idx" ... DATAVIEW_DUMP="<EP_
ROOT>\axalant\dmp" ...>

Environment Node
Environment>       
           <intel-ms-nt6.1/>
       </Windows>
       <Unix ... >
           <i686-linux-ol6/>
           <rs6000-ibm-aix7.1/>
           <sparc-sun-solaris11/>
           <ia64-hp-hpux11.31/>
       </Unix>
   </Environment>
 

Environment variables for the EDM Server process can be set here, or in the startup scripts 
defined above.

These values will overwrite all previously defined values from e.g. startup scripts.

Attribute Description Values Optional Example

Mode Logfile mode. For 
CpsVerify the value is 
overwritten by user 
specific default "CPS_
LOG_FIL_MOD". So 
adapt the default instead 
of changing value here.

trunc = truncate log 
message file before 
writing log messages

append = append log 
messages to file

yes Mode="append"

Prefix Prefix for logfile. Not 
evaluated yet for 
CpsVerify, prefix is 
always set to value 
"CpsVerify".

CpsVerify yes Prefix="CpsVerify"

Attribute Description Values Optional Example

Report_
Service_
URL

Lightweight reporting URL, 
generated automatically. 
URL on the configured 
Oracle WebLogic Server.

http://www.example.com:7103/Agil
ePlmWps/reporter/report
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